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Software License And Warranty Agreement

Carefully read all of the terms and conditions of this license agreement before using the software (“Software”).
By opening this package, you indicate your complete and unconditional acceptance of these terms and
conditions.

This document is a legal agreement between you, the licensee and UTEX Scientific Instruments Inc.
(“UTEX”) concerning the use of the Software. This agreement constitutes the complete agreement between
you and UTEX.

AGREEMENT
1. LICENSE

UTEX grants the licensee a non-exclusive license to use the Software in this package on one (1) server/workstation in
a single network installation, which installation shall consist of no more than 500 servers/workstations. A network is
defined as any continuously connected group of computers on one cabling scheme without hardware or software bridges.
UTEX retains title to and ownership of this copy and all backup copies and any proprietary rights related to the Software.
You may make copies of the Software for backup. You may not; copy the User’s or Reference Manual except as a
complete un-modified document for the internal use of the licensee, make alterations or modifications to the Software,
or attempt to discover the source code of the Software. The Software may not be sublicensed, rented or leased. Both the
license and your right to use the Software terminate automatically if you violate any part of this agreement. In the event
of termination, you must immediately destroy all copies of the Software or return them to UTEX.

2. LIMITED SOFTWARE WARRANTY

If you discover physical defects in the media on which the software is distributed or in the User’s or Reference Manual,
UTEX will replace the media or manuals for a period of ninety (90) days after purchase by the retail customer. You
must return the disk or manuals to UTEX or an authorized dealer within the warranty period, accompanied by proof of
purchase.

This warranty does not apply to defects due directly or indirectly to misuse, abuse, negligence, accident, repairs, or
alterations made by the customer or another party or if the hard lock serial number has been removed or altered.

UTEX disclaims all implied warranties, including without limitation warranties of merchantability, performance
and fitness for a particular purpose. UTEX will not be liable for any bug, error, omission, defect, deficiency, or
nonconformity in any software. As a result, the software is sold “as is” and the purchaser assumes the entire risk as to
its quality and performance.

3. LIMITATION OF LIABILITY

UTEX shall in no event be liable for direct, indirect, special, incidental, contingent, or consequential damages resulting
from any defect in the software or its documentation, including damages from loss of data, downtime, goodwill, damage
to or replacement of equipment or property and any costs of recovering, reprogramming, or reproducing any program or
data used in conjunction with UTEX products, even if UTEX or an authorized dealer has been advised of the possibility
of such damages. You agree that UTEX" liability arising out of contract, negligence, strict liability in tort or written or
oral information or advice given by UTEX’ dealers, distributors, agents, or employees will in no way increase the scope
of this warranty. Nor may you rely on any such written or oral communication. (Some provinces/states do not allow the
exclusion or limitation of implied warranties or liability for incidental or consequential damages, so the above limitation
may not apply to you. This warranty gives you specific legal rights and you may also have other rights which vary from
province to province or state to state.

4. GENERAL

If any provision or portion of a provision of this Agreement is determined to be invalid under any applicable law, it shall
be deemed omitted and the remaining provisions and partial provisions of this Agreement shall continue in full force
and effect.
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Using this manual

This User Manual shows you how to use Winspect to perform nondestructive inspections. It does not contain
information about configuring or installing an inspection system. It will provide you with basic Winspect
knowledge, for an already configured machine or system. It is recommended that you take the time to read, or
at least review, the entire user manual before operating Winspect.

How to find information in the User Manual

This manual is organized to lead you through the tasks of using Winspect to select an instrument and an
inspection method, perform a scan, collect the data, and manage the results. Each chapter is divided into
sections that describe a specific task.

Each section is self-contained. Once you are familiar with Winspect, you may only need to refer to this manual
for new tasks, or tasks that you perform infrequently. This manual is designed so that you can quickly flip to the
section that interests you, and find all the information needed to perform basic user tasks.

Conventions used in this manual

The following conventions are used in this manual:

Angle brackets enclose the name of a key, or a set of keys that you must press to
perform an action. If multiple keys must be pressed at the same time, they will all
be enclosed within one set of brackets. For example, the common Windows reboot
command is <Ctrl-Alt-Del>.

Bold text is used to highlight the name of a window or dialog box that contains a
group of related tools. For example: the Winspect Instrument Manager window
contains all the tools you need to view and control your ultrasonic and eddy current
instruments.

Window

Menu Items Bold and italic text is used to identify a Winspect menu item.

The arrow symbol is used to indicate a sequence of selections or options that will
Menu = Commands lead you through a menu list or dialog box. For example: To open a new Workspace,
click the mouse on the menu command: File = Open Workspace.

The pointer symbol is used to highlight an important note.

=
B The yellow triangle indicates a strong caution.

Indicates that additional information is available and tells you where to find it.

Contacting UTEX

You can reach us at:

UTEX Scientific Instruments, Inc.

2319 Dunwin Drive, Unit 8

Mississauga, ON Canada L5L 1A3

Telephone: (905) 828-1313 Fax: (905) 828-0360

Email: tech-support@utex.com Website: http://www.utex.com

Please have your Winspect Software License number available so that we may serve you more efficiently.

UTEX Scientific Instruments Inc. ©2004
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Chapter 1 — Using Workspaces

Whenever you are using Winspect, you are operating within a Workspace. This chapter explains how they work,
and how to use them to get the most out of Winspect.

Understanding Workspaces

Workspaces are the foundation on which Winspect data acquisition systems are built. A Workspace is made up
of several components that provide all of the functionality of Winspect. These components are the: Instrument
Manager, A-scan Instrument Display, Motion Controller, Scan Controller and Viewer Windows. Winspect
saves the configuration of each component in a Workspace file. This allows you to save your work in progress,
and restart in exactly the same state as when you left Winspect.

Workspaces are the best way to organize your work for several reasons:

* They are convenient way to organize your work by job and by the type of work being done. For
example: you can have one a Workspace for a repeated task like scanning a particular part, and
another Workspace for analyzing the scan data from that inspection.

* They are the most convenient way to save your work, because they save all instrument settings,
viewer settings, and scanning configurations in one location.

*  They reduce wasted time due to errors - just reload the last good Workspace.

*  Workspaces can be copied between machines, so that you can set multiple machines up exactly
the same way.

Working with Workspaces

Using Workspaces within Winspect essentially consists of four commands: Open, Save, Save As and Clear.
A Workspace file name can be up to 256 characters long. The file must have a file name extension of .ws3
in order for Winspect to recognize the file as a Workspace. For example: Sample XY Scan.ws35, or Tank

Scanner.ws5

The Winspect main toolbar has an indicator box which shows the name of the current Workspace.

File Instruments Motion Scanning Display Options Reporting  Processing  Help

EE E
: sinulated 2.0 scan fine resolution
TEascan Instrument Di Bt Ei gL ] B
0 Simulated multi-probe scanhing i
file Instrument Gates [cinlated tansducer characterizafinaai
rers IS time-based scan ‘ - -+ (362
|n§|'—'|@‘v\ielcome /‘|L_’|*§|DE

To open a different Workspace from the current Workspace folder, click the ¥ button at the right of the
Workspace indicator box. Choose a new Workspace from the list by clicking on it.

Click the @ button on the Winspect main toolbar to select a Workspace file to open. This is also used to

change the current Workspace folder for the selection box above.
You can also click on the menu command: File = Open Workspace.
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Click the E button to save your Workspace.

You can also click on the menu command: File = Save Workspace.

If you are using a Workspace you opened from a saved file, Winspect will save the changes under the original
Workspace file name. If you have not already assigned a name to the Workspace, you will be prompted for
one.

To save your Workspace with a new name, click on the menu command: File = Save Workspace As...
You will be prompted to name the Workspace.

It is helpful to use a file name that describes the work being done, or the inspection method, instead of a date or
an operator’s name. This will make the file name more meaningful when you return to open previously saved
Workspaces. For example: Wing Section XYZ123 Rib Scan.ws5 is a more descriptive name than Bob
July072001.

& Workspaces do not save scan data that is resident in memory when Winspect shuts down. The
Workspace file contains only the instrument configuration that generated the scan data. Remember
to save your scan data after it is collected.

@ See Chapter 8 — Performing the scan for more information about saving data files.

You can clear all settings and configurations from the existing Workspace by clicking on the menu command:
File = Clear Workspace. You will be prompted by Winspect to confirm that this is really what you want to
do. If you click YES, Winspect will completely clear the Workspace, including any instrument settings, scan
configurations etc.

Backup copies of Workspaces

’2 You should save backup copies of your Workspace files somewhere remote from the computer
- where Winspect is installed. In the event of human error or a computer failure, you will be able to
recover much faster than rebuilding the Workspaces from scratch.

Set the properties of these back-up files to “Read Only” to avoid accidental alterations.

Understanding Workspace components

The main components of Winspect are always active and present, but they are not always visible on the
screen.

This helps to reduce visual clutter by allowing you to reveal or hide components only when you need to work
with them. It is important to note that these components continue to operate, even though they may be hidden.

You can reveal or hide a component by clicking the appropriate button on the Winspect main tool bar. The
button will appear depressed if the component is active, and flat when it is hidden.

You can also click on the menu command: Instruments = Instrument Manager.

2 UTEX Scientific Instruments Inc. ©2004
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Show or hide the A-scan Instrument Display

You can also click on the menu command: Instruments —> Live Displays —> A-scan instruments.

Show or hide the Point Data Display
You can also click on the menu command: Instruments = Live Displays = Point Data Display.

Show or hide the Eddy Current Instrument Display

You can also click on the menu command: Instruments = Live Displays = Eddy Current
Instruments.

% Show or hide the Motion Controller.
You can also click on the menu command: Motion > Motion Controller.

Show or hide the User-Defined Information.

You can also click on the menu command: Scanning —> Collected Data —> User-defined
Information.

]

You can also click on the menu command: Scanning = Scan controller.

Show or hide the Scan Controller.

& Winspect component windows can also be minimized like any other window. Pressing the Hide/
Reveal button for a component will also restore a minimized window.

Viewer windows are the only components of Winspect Workspaces that do not exist all of the time. They are
opened when you need to view or edit data, and closed when you are done. Viewer windows operate differently
from other components because they may be used to show on-line data as it is collected, or they may be used to
show stored data from files. Viewer windows may be minimized and restored like any other window, by clicking
on the buttons at the top right of the window. The Winspect toolbar includes a single button that minimizes all
viewer windows simultaneously.

£
—E Minimizes and restores any open Viewer Windows.
If multiple windows are open they will all be minimized and restored at the same
time. This button will minimize all of the following types of viewers:
i Line Plot Viewer.
Color Plot Viewer.
i
Eddy Current Plot Viewer.
@ For more information about the function of these viewers, please see the Reference Guide.
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Using Workspace Descriptions

Workspace descriptions are optional files that can be extremely valuable when appended to the Workspace file.
They can provide supplemental information that explains how the Workspace is configured, how to use the
Workspace, or even an inspection procedure.

Show or hide the Workspace Description.
You can also click on the menu command: File = Workspace Description.

Workspace Descriptions are versatile. They can include text, graphics, video, and sound or contain complete
documents that help you get the most from the Winspect system. The Workspace descriptions can use controls
that link directly into Winspect itself. Using these controls through links or buttons, a user can operate Winspect
directly from a properly configured Workspace Description file.

Examples of Workspace Description documents include:
*  Explanation of the Workspace configuration.
*  How to perform the inspection that this Workspace was set up to do.
* How to configure the object or parts to be inspected.
¢ Guidelines for transducers, couplant etc.
*  On-line documentation for any non-Winspect components of the inspection system.

By default, Winspect starts with a “Welcome” Workspace that uses Workspace Descriptions to introduce many
sample Workspaces. To turn off this function, simply uncheck the menu item: Options = Workspaces = Use
Welcome at Startup.

Note: Workspace description files are optional. A description document will only be available if you or your
system administrator have created one for a specific Workspace.

Specifying Workspace options

Winspect can be configured to store and retrieve Workspaces in ways that are convenient to you.

File locations

Winspect allows you to specify where you would like to save your Workspaces. This makes it easy to organize
them by task, inspection method, or department. When Winspect is first installed on a computer, it loads sample
Workspaces into a folder called C:\Winspect\Workspaces. You can add new folders to this folder, or create
folders on any disk drive accessible from your system.

To specify a new default location for your Workspace files, click on the menu command: Options = File
Locations.

A dialog box will appear which allows you to specify where all of the resources used by Winspect are stored.
Type the complete path including disk drive letter and folder names into the Workspace box.

You can also use the Browse button to search for the folder if you do not know the exact path.

4 UTEX Scientific Instruments Inc. ©2004
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Note the check box at the right hand side of the window that reads Record Last Location. If this box is
checked, Winspect will record whatever folder the last Workspace was saved to, or opened from. Winspect will
return to that same folder the next time you save or open a Workspace file.

*  Check this box if you want Winspect to automatically return to the last folder you used.
* Leave the box unchecked (empty) if you want Winspect to always return to one specific folder
for Workspace file saving.

Reloading the last Workspace used

Winspect can be configured to re-open the last Workspace that was used. This can be very handy if you are
working using a specific Workspace, day after day.

To activate this option, click the mouse on the menu command: Options = Workspaces — Load last
Workspace.

This option can be checked to override the default option: ““ Use Welcome at Startup”

Reloading data files automatically

Winspect can also be configured to re-open a Workspace with the same data files that were open when you shut
down. This can be very useful if you are working on a data file, perhaps making annotations or measurements,
and you need to stop.

To activate this option, click the mouse on the menu command: Options > Workspaces — Reload Data
Files.

Winspect will include the names of the data files in the Workspace description. When you re-open that
Workspace, those data files will be reloaded into the appropriate viewer windows.

Remember that Workspaces do not save the actual scan data when Winspect shuts down. The
data must be saved in a data file. Winspect will reload those data files when that Workspace is
recalled.

@ See Chapter 8 — Performing the scan for more information about saving data files.
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Chapter 2 — Controlling scanner motion

This chapter deals with using Winspect to move the scanner under manual control. You will need manual
control of the scanner to perform a variety of tasks, including positioning of the scanner prior to performing an
automated scan.

Manually controlling the scanner with Winspect

You can move most types of scanner using hand wheels, joysticks, keyboard cursor keys, or Winspect on-screen
controls. Not all scanners are fitted with joysticks or hand wheels. Winspect systems always have available the
keyboard cursor keys and on-screen controls.

Using the Winspect Motion Controller
As explained in Chapter 1, the Winspect Motion Controller is always active and available:

i

Click the on the Winspect toolbar to reveal the motion control tools.
You can also click on the menu command: Motion Control = Motion Controller.

## Motion Controller ;lglil

File Edit Update

% Anis B |K2 v asis BRI 2 avis_ x|
0.000 in 0.000 in 0.000 in
0.000 infsec 0.000 infsec 0.000 infsec
Forward | Stop | Forward | Stop | Jog + | Stop |
Backwardl Goto | Backwardl Goto | Jog - | Goto |

The appearance of the motion control window will depend upon what axes have been configured for your
machine. In the example above, the scanner is a simple 3-axis system, with linear axes configured as X, Y and
Z. The X and Y-axes are in run mode, and the Z-axis is in jog mode.

The Motion Controller has a menu bar for file opening and saving, as well as axis creation and configuration.

Each axis configured within the controller has its own window with manual controls and position information.
The readouts give the current position and speed of each axis. Each axis may also have keyboard cursor keys
assigned to control forward and backward motion. All of these controls will be discussed in detail below.

Each axis also has its own drop-down menu for axis configuration and control. To open the axis menu, click the
WV button at the top left of the axis window.

UTEX Scientific Instruments Inc. ©2004 7
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Stopping all motion

The fastest way to stop a scanner is by hitting the space bar on the keyboard. You can also press the <ESC>
key or click the Stop button of the appropriate axis in the Motion Control Window.

"-. Note: Many scanners are equipped with red emergency stop buttons. These are typically used only
in the case of an emergency when the scanner has lost control. Don’t use these buttons for regular
controlled operation.

Under normal circumstances, it is better to use the programmed controls.

Understanding Jog and Run modes of motion

Winspect motion controls can be set to operate in one of two modes, called Jog and Run. To switch between
these two modes, click the axis menu ¥ button in the top left corner and then click on Jog/Run Toggle.

In Jog mode, the on-screen buttons appear as Jog + and Jog -. Both the on-screen buttons and the keyboard
controls will move the axis forward or back a fixed distance every time the command button or key is pressed.

In Run mode, the on-screen buttons appear as Forward and Backward. The on-screen and keyboard controls
will both move the axis at a fixed speed. This motion is continuous, and the speed remains constant until
another command is issued.

Running at various speeds

Each press of the Forward and Backward buttons in the motion control window progressively increases or
decreases the speed of the axis. There are four speeds for both forward and reverse motion. By default, the
speeds are set at 5%, 20%, 50% and 100% of the maximum speed allowed for the axis. These speeds can be
changed to suit your particular system.

& Remember press the spacebar or <ESC> key to stop all motion.

For example: Pressing the Forward button twice on a stationary axis will move the scanner at 20% of top
speed. Pressing the Backward button once will reduce the speed to 5%. Pressing the Backward button again
will reduce the speed to zero and stop the axis.

You can also use the keyboard cursor keys to control the direction and speed of an axis. You must assign

cursor keys to these controls.

@ See Editing an axis later in this chapter to learn how to configure these controls.

8 UTEX Scientific Instruments Inc. ©2004
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Jogging a fixed distance

The Jog+ and Jog- buttons move an axis forward or backward a fixed distance. Each press of a jog button
moves the axis by one step.

The jog step size determines the distanced traveled by the axis. This value is set up in the axis configuration
window. One value is used for both the Jog+ and Jog- distances.

A When jogging a fixed distance, the axis travels at maximum speed.

The keyboard cursor keys can also be used to jog an axis. If cursor keys have been assigned to control the
running direction and speed of an axis, the same keys will jog the axis.

You can also use the keyboard cursor keys to control the jogging of an axis. You must assign cursor keys to
these controls.

@ See Editing an axis later in this chapter to learn how to configure these controls.

Going to a given point
The quickest way to go move an axis to any position is to press the button on that axis. You will be
prompted with a pop-up box like the one below:

You can type a distance and press <Enter>, or click on one of the three pre-programmed Goto points.

Any Goto position can be defined as an absolute
or relative position on the axis. | Custom Gote
e An absolute position is defined from ¢ Relative | | @ MNomal Approach I Ll
the zero pOiIlt of the axis.  Absolute| | £ Approach From Offset ’TI

e A relative position is defined with
.. r— PreFrogrammed Gotos
respect to the current position of

the axis. 0.000 mm [ Relative, Maormal Approach | |
0.000 mm [ Relative, Mormal Approach | |
Click the Edit button on the Goto controls

. 0.000 mm [ Relative, Mormal Approach | |
window to configure the three pre-programmed
Goto positions for this axis.

Edt | Cancel |

Goto positions can be approached directly or from an offset position. This allows you to compensate for scanner
backlash. The scanner will overshoot the Goto position by the offset distance, then approach the position from
the opposite direction.

Click the Edit button on the Goto controls window to set the offset distance for this axis.

‘2 When a Goto feature is used the scanner moves to the specified position at the maximum axis
= travel speed.
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Using the Position Manager

The Position Manager enables Goto commands that operate on more than one axis at a time. It operates in
conjunction with the Motion Controller, although it is a separate window.

Click on Motion = Position ]

quager on the Winspect @ - . T =

main menu bar, to .open the  [Ef)} Gato 050 05 Record Nows

Position Manager window. Riitoe |Soan Skl 15 15 Record Now
@ Goto  [Mew Poazition 1 0.000 0.000 Record Mow

Use the Position Manager to
create and edit any number of @
multi-axis Goto points.

4] >|\ Position Manager / 4| >|
i

Coordinates can be entered
manually, or you can capture the current position of the scanner using the Record Now button for the Goto
point.

Click the @ button in the Position Manager for tips about controlling how the Goto movement is
executed.

Winspect automatically configures the Position Manager to match the current Motion Controller configuration
for the Workspace.

The positions in the Position Manager are saved with the Workspace, just like the settings for any other
Workspace component.

Resetting a position readout

You can reset the position readout on any axis.

To zero an axis position readout:

Double-click on the position read-out to reset it to zero.

To reset an axis position to a different value:

Right-click in the position readout, and select Set Encoder to... from the pop-up menu

The encoder zero feature is useful because you can define zero to be anywhere along the travel of an axis, and
Winspect will perform all position calculations from this new zero point. For example: it is helpful to reset the
scan and index axes to zero just before you begin an automated scan. If you need to stop the scan and re-start,
you simply return the scanner to the zero coordinates to get back to your starting point quickly and easily.
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Editing an axis
You can edit any axis to change the way it operates. This is useful when using a scanner to perform a variety of

jobs. Axis configurations are saved in the Workspace, along with all other instrument and scan configuration
parameters.

You should save a copy of the Winspect Workspace before making any configuration changes. You can also
save the motion control configuration separately by clicking the File > Save As command in the Motion
Controller window.

To edit an axis, click the ¥ axis menu button in top left corner of the axis readout and then select Edit from the
drop-down menu. The Axis Configuration window will appear.

x
— iz — Muation Control
Az Label: I>< A Acceleration : |—1D
Motion Contral; Simulated Mator, Ch, 0 t aximum Speed : |—1D
Encoder: Simulated Encoder, Ch, 0 Running Speeds: |_5°/, mx Wz 100 =
— Pasition Measurement Jog Step Size : 100
Uriitz: mm b Backward Maotion  Forward Mation

............................................... Buttan Label IBackward IForwald

™ Modulus Enabled -+ Rollover at; I 1 Key INDne j INone j

— Limits [ Disable " Disahle
[™ lgnore Hardware Limit Switches [ De-energize Axis After Each Mation
= o
™ Enable Software Limits:  Upper |54.539 V' Disable Watchdog

Aais stalled if within: | o
Lanwer |54.539

toves completed if within: 0m

Configure Hardwarel Edit Goto Settings | Ok I Cancel |

Caution! Changing some of the settings in the axis editor can drastically alter the way a scanner
operates, causing loss of calibration, equipment damage and personal injury. Do not attempt to
change the axis configuration without proper training and authorization.
Itis strongly recommended that you do not adjust the following settings without a clear understanding
of what you are doing, and a very specific reason for doing so:

. Units of measurement

. Ignore Hardware Limits

. Acceleration

. Maximum Speed

. Moves completed if within

L.::,,
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Configuring axis position measurement

In this section of the axis editor, you can:

e Select whether Winspect will ask you to confirm before zeroing the position readout.

e Enable the axis position readout to automatically rollover and start counting from zero at a given value.
This is used specifically when using a turntable or tube roller to reset the counter to 0 after one complete
360 degree rotation.

Setting software limit switches

You can set software limit switches, which will stop the axis motion at a specific point. Note that software
limits are relative, not absolute. If the axis position is reset, the software limits are calculated from the new zero
point on the axis.

ﬁ Caution! These software limits are a convenience feature, not a safety device! Hardware limit

= switches are recommended for most scanning systems. Hardware limits are absolute, and will
always stop the motion at a specific point on the axis. Use extreme caution if you decide to ignore
the hardware limits.

Configuring the motion profile

If you want to change the speed at which a scan is performed, use the speed controls in the Winspect Scan
Controller. See Chapter 7 of this manual for instructions. Do not use the Axis Editor to alter the acceleration
and maximum speed settings for your scanner.

You should not need to alter the acceleration and maximum speed settings of any axis, unless they have been
altered accidentally and the settings need to be restored. The best way to do this is to recall your default
Workspace, which has all motion configurations saved within it. If you want to preserve the current Workspace,
and only restore the motion configuration, you can recall the default motion description file, then save it with
the current Workspace.

Setting Jog step size
This setting controls how far an axis moves every time you press the Jog+ or Jog- controls. It is a good idea
to set this at no more than 1/10 of the axis length.

You may want to set relatively small jog steps when trying to position an axis accurately, and then reset the jog
step size to a larger value for general purpose positioning of the scanner.

Configuring the keyboard controls

You can assign keyboard cursor keys to control an axis. You can also assign a specific label to the on-screen
button that appears in the Motion Controller window. For example, you may want to label the Z axis controls
as Up and Down instead of Forward and Backward.

Remember, the keys assigned to Forward and Backward motion, will control both Run and Jog modes of
motion for the axis.

For multi-axis systems, you can also assign the <F2> to <F12> function keys to an axis.

12 UTEX Scientific Instruments Inc. ©2004
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A note about safety

"-. Please use extreme caution when using Winspect's motion controls with a scanning system.

Even small motors are powerful enough to cause serious personal injury, and damage the scanning rig or the
part begin inspected. The consequences are even greater for large scanning systems. Always be aware of the
potential for mishap, and take precautions to prevent accidents.

Make sure the path for scanner motion is completely clear before moving the scanner. If you have any doubt,
do not move the scanner. When working near the range of motion of the scanning system, use extreme care.
Motors and main controls should be powered down and locked out with a manual override if you are going to
be working inside the motion range of the equipment.

It is your responsibility to work safely at all times.
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Chapter 3 - Viewing Live Signals

There are two instrument displays and one data display that you can use to view live signals in Winspect.

Instrument Displays
e the A-scan Instrument Display
¢ the Eddy Current Instrument Display
» the Point Data Display

Note: All of the windows for displaying a live signal have the words “Display” in their title bars.

Selecting the right type of display

Each display type shows a specific type of signal or data. Select a display that is appropriate for the instrument
or signal source you need to monitor.

The A-scan Instrument Display is most often used to display ultrasonic waveforms. It can be configured with
a rectified signal display,like a flaw detector, or with an RF waveform display.

The A-scan Instrument Display can be opened in two ways:

b
L

Click the A-scan Instrument Display button on the Winspect toolbar.
You can also click on the menu command: Instruments - Live Displays - A-scan instruments.

The Eddy Current Instrument Display shows signals from both PC card-based instruments and from external
instruments. Refer to Chapter 4 for more details about using these eddy current instruments.

The Eddy Current Instrument Display can be opened in two ways:

;%

Click the Eddy Current Instrument Display button on the Winspect toolbar.

You can also click on the menu command: Instruments = Live Displays = Eddy Current Instruments.

The Point Data Display is a slightly different class of display from the other live signal displays. It can show
analog voltage signals acquired through a single-point analog-digital card. This function is most often used to
monitor external instruments or sensors.

The Point Data Display can also display data derived from another signal. For example, the amplitude of a
gated signal in the A-scan Instrument Display can be graphed as a strip chart in the Point Data Display. You
can show any measurement from any of the live instrument displays in the Point Data Display.

The Point Data Display can be opened in two ways:

=21
=

Click the Point Data Display button on the Winspect toolbar.

You can also click on the menu command: Instruments = Live Displays = Point Data Display.
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See Using The Point Data Display later in this chapter for more details about using this
@ versatile tool.

Viewing a specific signal source

If you have multiple signals or instruments, you can select which signal source to show in display window.
There are three ways to select a new source to display:

. = Click on the Next Instrument button on the toolbar of an Instrument Display window.

*  Click the menu command: Instrument = Next Instrument on the menu bar of the Instrument
Display window.

» Right-click the mouse inside the display window and select Data to Display from the pop-up
menu.

Using the A-scan Instrument Display

The A-scan Instrument Display is a powerful instrument. It has many useful features and tools for observing
and analyzing high-speed signals, including ultrasound A-scans.

b
Click the =21 button on the Winspect toolbar to reveal the A-scan Instrument Display.

You can also click on the menu command: Instruments = Live Displays - A-scan instruments.

The screen capture below illustrates some important features of the A-scan display:

1mi Ascan Instrument Display Delay Controls rr—— EI
File Imstrument Gates Yiew Update Range Tools  Window
He H p0P + MESE e+ &5 5Bt

can Simulator Time Slot 1: _1_-'3
Gain Control )

oom Controls
il F [---

lts
0
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1
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- 10 1= 10 5 30 3= 40 45 3

Time {(uzec)
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Live pan and zoom

The display has a live pan and zoom feature for controlling the horizontal zoom and panning of the signal
display, similar to the range and delay of a scope or flaw detector.

—F To change the Horizontal zoom of the display, move the mouse inside the A-scan display, the cursor
will change to this icon. Click and drag left or right to change the horizontal zoom.

E@ To pan the viewing area left or right, move the mouse cursor down to the horizontal axis; it will change
into a hand shape. Click and drag the mouse to pan left or right. This will only function if the display is zoomed
in more than the full range.

This feature is active by default. If the range and delay controls are not active, the cursor will not change shape.
To activate the controls, right-click the right mouse while inside the A-scan Instrument Display window, then
click Live Pan/Zoom X.

Using the right click menu

Most of the frequently used tools for manipulating the A-scan Instrument Display are available by right
clicking the mouse while inside the display. This opens a menu with several controls, including:

e Zoom In and Zoom Out
»  Live Pan/Zoom X toggle, which activates the mouse-drag display range and delay controls

« View Gate selector, to display the full A-scan range, or zoom into a magnified view of gate
contents.

*  Pulser & Digitizer selectors, to change the instrument or signal source that is being
displayed.

*  Gates controls, to add, delete gates, and edit their properties

These features will be discussed more deeply in subsequent chapters.

See Chapter 5 - Defining the source and type of data to be acquired, for information about
@ using gates.

Using the double-click controls

You can edit the properties of the A-scan display by double-clicking the mouse on the feature you want to
change.

Double-click:
* on a gate to edit the gate properties.
* in a blank region of the display to reveal the instrument manager controls.
* on the title bar of the display window to maximize the window. Double-click again to restore it
to its default size.
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Horizontal range limiting

The horizontal limit of the instrument display can be set to accommodate your echo delay times. For example:
if your back wall echoes occur at 35 ps, you may wish to set the maximum display range to 50 ps so that the
image is scaled for best viewing of the whole waveform when you zoom out.

When you zoom out to maximum range — the display will only zoom to the range limit you have set using this
command. Click the menu command: Range and select a range limit from the list.

Display zooming
The A-scan display has three Zoom controls: Zoom In, Zoom Out, and Zoom to Cursor. The zoom cursors are
two green brackets on the A-scan display, which can be dragged with the mouse to any part of the display.

Click the 2 button and drag a rectangle around the area of the display you want to magnify.

Click the 2 to zoom in to the area defined by the two green bracket cursors. Use the mouse
to move the cursors to new positions in the signal display window.

Click the L button to zoom the display out to maximum range.

Making simple measurements

You can use the mouse for making simple measurements in the A-scan window.

You must first switch off the range and delay controls to obtain a normal arrow cursor. Right click the mouse in
the A-scan Instrument Display, then click on Live Pan/Zoom X to deactivate this feature.

The cursor position is indicated at the bottom left of the A-scan Instrument Display. This is an absolute
measurement in time and amplitude (X,Y). Time is measured in microseconds (X) and amplitude is measured
in volts (Y).

To measure a difference, click and drag the mouse between two points. The cursor status will show the relative
difference between the start point and end point of the drag. This tool is useful for estimating delay times,
signal-to-noise ratios, etc.

Using multiple A-scan windows

The A-scan Instrument Display can show a split-screen or windowpane view. This is useful for showing two
aspects of the same signal, or even multiple signals, with each signal on a different source or channel. For
example, you might want to split the A-scan viewer, showing the whole waveform in one pane, and a zoom in
view of a particular echo in another:

O} || |[E

The A-scan pane buttons enable you to quickly switch between one, two and 4-pane views.

Additional window layouts are available. Click on the menu command: Window — Split Panes and select a
new layout.
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When you split panes, the new panes are made equal in size by default. You can change the relative size of split
panes by using the mouse: click on the border between panes and drag the border to re-size the panes.

Click on the menu command: Window - Equalize to restore all panes in the display to equal size.

To change the active windowpane, click the mouse inside the pane you want to become active. The title text of
the active pane is bold relative to the other panes and the small square at the top left is black in the active pane,
white in the other panes. Each pane operates the same way as a A-scan Instrument Display. The A-scan main
toolbar and menu commands such as Zoom and Signal Source apply to the active pane.

Using the “Accumulate A-scans” function

The “Accumulate A-scans” function retains the image of each A-scan in the display window, instead of
refreshing the image with each trigger of the instrument. This is useful for observing transient images.

To use this feature, click the menu command: Tools > Accumulate A-scans in the A-scan Instrument
Display window.

To refresh the display, click the menu command: Tools - Clear Accumulated A-scans in the A-scan
Instrument Display window. The A-scan display will be cleared, and will begin accumulating new images
with the next trigger.

This feature is useful for several tasks:

* Moving a transducer back and forth along its axis creates an image with a peak at the focal
point. Rotating a transducer’s swivel or gimbal mount produces a similar image with a peak
at the optimum angle. This enables you to quickly adjust your transducer fixture for optimum
signals.

* You can measure the wobble in an off-center axis, or an imperfect circular part, as they rotate
in real time.

* You can measure axial misalignment and thickness variation of scanned parts.

* You can capture transient echoes as the transducer is scanned over a part.

Controlling the digitizer trigger delay

You can control the length of the digitizer trigger delay from the A-scan toolbar.

—f— ——
Click on the == or 2] button to increase or decrease the trigger delay on the digitizer in increments of 5 ps.

These controls are useful to accommodate digitizers with limited data capacity, or scans involving long times of
flight. You can delay digitizing the A-scan signal until just before the signal of interest arrives at the digitizer.

Controlling receiver gain

If your pulser receiver has a Winspect interface, you can control the gain of your instrument directly from the
A-scan Instrument Display window.

I

To turn the control on or off, click on the button on the toolbar of A-scan display window. The gain control
appears as a slider at the right hand side of the A-scan display window.

Click the mouse on the slider bar, and drag up or down to change the pulser gain setting.
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Using the Eddy Current Instrument Display

Use the Eddy Current Instrument Display to monitor eddy current instruments. You can use the same display
window for both internal PC card type instruments, and for external instruments that Winspect monitors through
a point digitizer card.

Click the 3:1? button on the Winspect toolbar to reveal the Eddy Current Instrument Display.
You can also click on the menu command: Instruments = Live Displays - Eddy Current.
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File Instrument Display Gate Alarms  Yiew  Update  Window

| HE E 2L+ e 4o a
ECT = (0.00, 0.00) Volts

= ECT
-]

g />*f\

—_]

[ -0.4352, 03575

ECT

~Galell on ECT ﬂ ﬂ b ﬂ ﬂ
8

1 2 3 4 5 ] 7
28872, 0.9833) sec

Volts
0.0 05 1.0

As you can see in the image above, the standard Eddy Current Instrument Display has three regions:

* A text region at the upper left side, shows the voltage in X and Y (Real & Imaginary)
components. This text box can also display other information such as values within gates, and
alarm status.

* An impedance plane (Lissajous plot), shows the magnitude and phase of the signal. There are
three gates in this window, for measuring X and Y and magnitude, and there is an indicator
showing cursor position in (X,Y), which is also useful for making measurements.

* A strip chart at the bottom shows the X & Y voltages in a line graph. There are gates that

correspond to the gates in the impedance plane plot above. There is a second cursor position
indicator, which is useful for making measurements in the strip chart.
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To work in a particular region of the display, click the mouse in that region. The border of the active region is
darker than the others. All regions share the toolbar buttons and menu controls for the display window. If a
menu item is not valid for the active region, it will be shown as light gray.

Using the right-click menu

The eddy current display has a pop-up menu with frequently used tools. The available menu items may be
different for each region of the display. To view the menu for a display region:

e Click in the region to make it active.
* Right click to reveal the pop-up menu for this region.

Using the double-click controls

You can edit the properties of the Eddy Current Instrument Display by double-clicking the mouse on the
feature you want to change.

Double-click:
* on a gate to edit the gate properties.
* in a blank region of the display to reveal the instrument manager controls.
* on the title bar of the display window to maximize the window. Double-click again to restore it
to its default size.

Customizing the display configuration

You can customize the configuration of the Eddy Current Instrument Display window. Two standard layouts
are available. To select a different layout, click the menu command: Window — Layout.

&% Eddy Current Instrument Display 5 -0 x|

File Instrument Display Gate  Alarms  Wiew  Update  indow

HE ERLL e o4 o
Eddy Current on Notched Tube = (0.00, 0.00) Volts
o Eddy Current on Notched Tube Eddy Current on Notched Tube

1.0

uy
o

0.5

—i3atp|l on Tulg Wall Thickness Feal

//’ \ (Fatpl on Tuke Wall Thickness Imag
- . T |
- |/

Volts

Wy Wy
2 <
< =
— —
'-1.0 0.5 0.0 0.5 1.0 ! 1 2 3 4 & i} 7 8 9
{10644, -0.2970) 63107, 0.9901) Sec

EadyCarme iton Moched Tk

_Gate 11[.:_}'[1"@ Wall Tnilz[k_less ﬂ o ﬂ ﬂ

1 2 3 4 5 ] T 8 9
[ 45734, 0.9851) sec

Volts
00 05 1.0

UTEX Scientific Instruments Inc. ©2004 21



Chapter 3 - Viewing live signals Winspect User Manual

Layout 1 displays the standard 3-region plot with text, an impedance plot, and one strip chart.
Layout 2 displays a 4-region plot with two strip charts: one showing magnitude, and the other showing voltage
of both real and imaginary components in (X,Y)

You can change the size of any region of the display. Click and drag the mouse on the border between regions
to change their relative size. You can completely hide a region of the display to reduce clutter. You can
temporarily enlarge a portion of the display make measurements or adjustments, and then quickly return to a
multi-pane view.

Working with the Text Region

Click in the text region to make it active.

The text region always displays the real and imaginary components of the eddy current signal as (X,y)
coordinates.

If an alarm is configured for the eddy current signal, the alarm status is also displayed in this region.

The Right-click menu has controls to select which data to display. You can also modify the size of the text in
the display.

Working with the Impedance Plot

Click in the impedance plot region to make it active.

Display zooming

The main menu zoom controls are active in the impedance plot region.

Click the 2 button and drag a rectangle around the area of the display you want to magnify.
You can also use the Right-click menu command: Zoom In.

Click the L button to zoom the display out to maximum range.
You can also use the Right-click menu command: Zoom QOut.

Adjusting gates:

To move a gate in the impedance plot:

. Click and drag the circular gate to adjust the threshold of the magnitude gate.

. Click and drag the vertical bar to adjust the threshold of the Real (X) component gate.

. Click and drag the horizontal bar to adjust the threshold of the Imaginary (Y) component gate.

To modify the properties of a gate, double-click on the gate. A pop-up window appears, with controls for all
gate properties.
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Working with the Strip Chart

Click in the strip chart region to make it active.

Selecting what to display

Right Click and select Data Mode from the pop up menu.
You will be prompted to select whether you want to display the Magnitude, Phase, Real or Imaginary component
of the eddy current signal.

Display zooming

The main menu zoom controls are active in the strip chart region.

Click the 2 button and drag a rectangle around the area of the display you want to magnify.
You can also use the Right-click menu command: Zoom In.

Click the L button to zoom the display out to maximum range.
You can also use the Right-click menu command: Zoom Out.

The strip chart regions of the display also have a Live Pan and Zoom control.

To enable Live Pan and Zoom, right-click the right mouse inside the strip chart, then click Live Pan/Zoom
X

You can also use the menu command View = Live Pan/Zoom on the main menu bar of the display window.

¥ To change the length of the region displayed, move the mouse inside the strip chart display, then click
and drag left or right. Left increases the display range; right decreases the display range.

@ To pan the displayed region, move the mouse cursor down to the horizontal axis; it will change into a
hand shape. Click and drag the mouse to pan left or right.
This function is valid only when the strip chart display is zoomed in.

If the cursor does not change shape, the Live Pan and Zoom controls are not active. Activate them as
instructed above.

Setting the horizontal range
The strip chart will scroll automatically when the graph reaches the right edge of the window.

To can change the width of the strip chart window:
1. Right click to reveal the pop-up menu.
2. Click to select Display Properties. A menu box will appear.
3. Inthe Length box, type a new value for the strip chart window width.
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Making simple measurements

You can use the mouse for making simple measurements in the strip chart and impedance plot regions of the
eddy current display.

Click in the region to make it active.

The cursor position is indicated at the bottom left of the display. This is an absolute measurement in voltage of
the X or Y component, (on the vertical axis) and time or distance on the horizontal axis of the chart.

To measure a difference, click and drag the mouse between two points. The cursor status will show the relative
difference between the start point and end point of the drag.

& In the strip chart region, you must first switch off the Live Pan and Zoom control to obtain a normal
arrow cursor. Right click in the strip chart region, then click on Live Pan/Zoom X to deactivate this
feature.

Monitoring multiple instruments

Each current instrument is configured as a separate channel in the Instrument Manager. The instrument
manager registers each instrument in a timeslot. A complex inspection system may include several instruments,
each with its own timeslot.

Click the = button on the toolbar to display the next instrument.
You can also click the menu command: Instrument - Next Instrument.

Using the Point Data Display

The Point Data Display is a versatile tool that can display a variety of data. It can display discrete signals that
are acquired through a single-point digitizer, or it can display values derived or measured from other signals,
such as gated A-scans. You can configure the display to show several graphs at the same time, regardless of
their source, and you can plot these values based on time or distance along a motion axis.

n=2.1
Click the === button on the Winspect toolbar to reveal the Point Data Display.
You can also click on the menu command: Instruments - Live Displays - Point Data.

In the next two sections, we will discuss these two ways of using the Point Data Display.

Monitoring external instruments and sensors

The Point Data Display can be used to monitor voltage signals received through a low-speed A/D card. Winspect
supports several such cards from vendors including Data Translations™, and National Instruments™.

In this way, you can use the point data display to perform useful tasks such as reading simple sensors and
monitoring a variety of external instruments. Winspect can collect and save all of this data in a Winspect scan
file.
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% Point Data Display = | Ellil

Flle Sources Gates Alarms  Calculators  Wiew  Update  Window

B2 B e L+ |e4 0000

ID TOF = 27.79 Uszec 10 TOF

B TOF = 1.70 Usec i'

Wyall Thickness = 7.41 mm g

larm on Gate 1 on Wall Thickness =2
ﬁ_w

(0.0395, 22.2559)

" BEvy TOF VWall Thickness
B ]
LRy i

10
)

pa|Alarm Gate on Wall Thickness

wy
= 1 2 3 4 £ & 7 LS 2.0 2.5 3.0 3.5 40 4.5
sec sec

( 6.5347, 2.5038) 1.4770, 9 2656)

Monitoring simple sensors

The Point Data Display can show scaled values for simple sensors, such as thermocouples, position sensors,
and pressure or force transducers. These sensor signals must be properly conditioned for the digitizer inputs,
which accept voltage signals in a variety of configurations (unipolar/bipolar, differential/single ended, etc.).

Monitoring external instruments

Use the Point Data Display to monitor and record the output of external instruments such as ultrasonic flaw
detectors and thickness gauges.

Most stand-alone instruments have a voltage output that represents some value measured by the instrument,
such as thickness, amplitude or time-of-flight of a gated signal.

This capability is not restricted to ultrasonic instruments. Winspect can transform almost any simple instrument
into a powerful data acquisition, measurement and analysis system.

Monitoring external eddy current instruments

As with all external instruments, a single-point digitizer card is used to monitor an external eddy current
instrument. Winspect records the X and Y voltages output by the eddy current instrument through the digitizer
card. The Point Data Display can display and record the X and Y eddy current voltage as simple strip charts.

You can also configure Winspect to specify that you are monitoring eddy current instruments with the digitizer
card. Winspect will interpret the adjacent voltage inputs as an (X,Y) pair instead of discrete signals, and will
use the Eddy Current Instrument Display to show the signals from the external instrument in the same way an
internal PC-card based instrument is displayed.

See Chapter 4 - Adjusting Instrument settings for more information about configuring single-
@ point digitizers to monitor external instruments and sensors.
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Displaying measured and calculated values

The Point Data display can also be used to display single point data that does not come from a discrete voltage
signal acquired through a digitizer. This display is capable of monitoring any single point data that is extracted
or calculated from any signal source.

In this example, the Point Data Display is monitoring two gates collecting Time of Flight (TOF) data from the
A-scan of a tube inspected from the inside out.
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The upper strip chart plots the TOF to the inside wall of the tube.

The lower strip chart plots the TOF to the back wall of the tube.

Using the single point display controls

This section describes how to use the most important features of the Point Data Display.

Live pan and zoom

The Point Data Display has a live pan and zoom control.
To enable Live Pan and Zoom, right-click the right mouse inside a strip chart, then click Live Pan/Zoom X.

You can also use the menu command View — Live Pan/Zoom on the menu bar of the Point Data Display
window.
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¥ To change the length of the region displayed, move the mouse inside the strip chart display, then click
and drag left or right. Left increases the display range; right decreases the display range.

ﬁy To pan the displayed region, move the mouse cursor down to the horizontal axis; it will change into a
hand shape. Click and drag the mouse to pan left or right.
This function is valid only when the strip chart display is zoomed in.

If the cursor does not change shape, the Live Pan and Zoom controls are not active. Activate them as
instructed above.

Using the right-click menu

Right-click in the display window to reveal a pop-up menu that has some commonly used tools on it.

* Zoom In and Zoom Out

* Live Pan/Zoom X toggle, which activates the mouse-drag display controls

* View Gate selector, to display the full A-scan range, or zoom into a magnified view of gate
contents

* Qates controls, to add, delete gates, and edit their properties

* Data to Display selectors, to change the instrument or signal source that is being displayed

Using the double-click controls

You can edit the properties of these displays by double-clicking the mouse on the feature you want to change.

Double-click:
e In any blank region of the display window to reveal the Instrument Manager, showing the
controls for this instrument or signal source.
* on a gate to edit the gate properties.
e on an alarm to edit the alarm’s properties.
* on the title bar of the display window to maximize the window. Double-click again to restore it
to its default size.

Configuring the Data Collection Properties

The single point displays can be configured to match the

source of their single point data. This makes the strip
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Position Window configures the horizontal axis of the strip chart in linear or angular units. Data is displayed
according to the point at which it was collected. You must have one or more motion axes configured in the
Motion Controller, in order to collect and display single point data in this mode.

Sample Interval defines the distance or time between sampling of the single point data source.

Starting Position enables you to offset the collection and display of data from the default (zero) starting
point.

Motion Axis links the display to a specific axis. Click the ¥ button to select an axis from the list. You must
have one or more motion axes configured in the Motion Controller, in order to collect and display single point
data in this mode.

Display zooming
The single point displays have controls to Zoom In, and Zoom Out to any part of the display.

Click the 2 button and drag a rectangle around the area of the display you want to magnify.

Click the L button to zoom the display out to maximum range.

Making simple measurements

You can use the mouse for making simple measurements in the single point display windows.

You must first switch off the Live Pan and Zoom controls to obtain a normal arrow cursor. Right click in the
strip chart, then click on Live Pan/Zoom X to deactivate this feature.

The cursor position is indicated at the bottom left of the window. This is an absolute measurement of amplitude
(vertical axis) and time or distance (horizontal axis).

To measure a difference, click and drag the mouse between two points. The cursor status will show the relative
difference between the start point and end point of the drag.

Using multiple windows

The single point displays can show a split-screen or windowpane view. This is useful for showing two aspects
of the same signal, or even multiple signals, with each signal on a different source or channel. For example,
you might want to split the viewer, showing the whole strip chart in one pane, and a zoom in view of the last
few seconds in another:

O] |5 |[E

The pane buttons enable you to quickly switch between one, two and 4-pane views.

Additional window layouts are available. Click on the menu command: Window — Split Panes and select a
new layout.

When you split panes, the new panes are made equal in size by default. You can change the relative size of split
panes by using the mouse: click on the border between panes and drag the border to re-size the panes.
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Click on the menu command: Window - Equalize to restore all panes in the display to equal size.

To change the active windowpane, click the mouse inside the pane you want to become active. The title text of
the active pane is bold relative to the other panes and the pane appears depressed. The main toolbar and menu
commands such as Zoom and Signal Source apply to the active pane.

By splitting the display window, you can simultaneously display both the strip chart and numeric value of a
single signal, or you can display multiple signal sources.

Viewing multiple signals

If you have multiple sensors or instruments that you need to monitor, you can view these signals individually,
or simultaneously.

To view one signal at a time:

Click the button to step through each signal source monitored by the Point Data Display.
You can also click the menu command: Instrument > Next Instrument.

% Point Data Display ;lglil

File Sources Gates Alarms  Calculators  Wiew  Update  Window

H&E | E 2L+ e 4000H
IO TOF = 26.02 Usec

BYWY TOF = 1.92 Usec

B\ - 2nd BYY TOF = 1.71 Usec

ECT = {0.00, 0.00) Yaolts

Alarm on Gate 1 on D TOF

1D TOF ECT

15

Usec
0.0

Jo

5 el onID TOF s
/F‘\/ =I.'

'-L0 -0.5 0.0 0.5 1.0

25
L0

1 2 3 4 &5 & 7

c

(71143, 419193 ( -1.0750, 0.0625)
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To view multiple signals:
Split the display window into panes to view as many signal sources as you have.
Then select a signal source to be displayed in each pane.

* Click in a pane to make it active.

*  Then, right-click, and select Data to Display

Using Gates and Alarms

You can set a visual and audible alarm on any point data or point digitizer channel you are monitoring. This is
useful if you want to be alerted when a threshold has been crossed by the signal.

To set an alarm, you need to gate the single-point data. The alarm is triggered by the signal crossing the gate
threshold, either up or down. The alarm’s name and status is displayed as text, so you must have a two-pane
display showing the gated signal in one pane, and text in the other. Gates and Alarms are available in both the
Point Data Display, and the Eddy Current Instrument Display windows.

Setting Gates:
Gates may only be set up in a strip chart display window. They cannot be added from the text display panel.

e Click in the strip chart window to make it active.
* Right click and select Add Gate &3 point Data Display 1ol x|

File Sources Gates Alarms  Calculators  Wiew Update  Window

Click and drag a gate to adjust the gate |H&|E |2 2 « | e 4 OO0
start, length and threshold level. ID TOF = 27.88 Usec Wall Thickness = 1.78 us

Internal Wall Flaw Wall Thickness

Double-click on a gate to edit its properties;
you can assign it a name and a color.
Wall Thickness

You can add several gates to one signal. m__U V U
i —
2 = [rate 1 on Wall Thickdess
Ay
i
L=
1 2 3 4 5 6 7
(00173, 1.4792) sec
ID TOF
=
-
2
=R
ate
1 2 3 4 5 6 7
{ 30831, 41 2160} sec
& Note that gates in the point data window do not collect data. They exist to enable the use of alarms.
Single point data is already being collected for each channel you have configured in the Instrument

Manager.
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Setting Alarms
You can set an alarm that will be triggered when the signal crosses a gate’s threshold. Alarms can be set from
any text or strip chart pane.

To add an alarm:

Click the menu command: Alarms - Add Alarm. This will pop up the Alarm Properties box.
e Type in a name for your alarm. This will be displayed in the text window.
+ Select a source for this alarm. Click the ¥ button to see the list of gates you can use.

Configure the alarm properties:
*  Set how the alarm is triggered with respect to the threshold of the source gate
* Select whether to have an audible

alarm. ﬂ
*  Specify a color for the alarm. It is
Cancel |

helpful to use different colors if you ﬂl
have more than one alarm.

M arne Alarmn om Gate 1 -
Source 1 Gate 1 on'wall Thickness d
The name of the alarm is displayed in the text TEES TR
window of the Point Data display. When the Condition < [Less Than) -
alarm gates threshold is crossed, the text will Audiodlam [ Tue (& False
flash in the alarm’s color. If Audio Alarm is Calor I - |
selected, the speaker of the host computer is
beeped.
Helpful tips for alarms

You can also establish a dual-level alarm. Set one alarm gate at a medium threshold, and define its color as
yellow. Set another gate on the same signal, with a higher threshold, and define its color as red.

You can use two alarms to monitor a high-level and low level on the same signal. Set the high level alarm to
trigger when the signal is greater than the threshold. Set the low level alarm to trigger when the signal drops less
than its threshold. As long as the signal level remains between the two thresholds, no alarm will be triggered.
Experiment with setting alarms on a variety of gated signals.

Using simulated signals

Winspect has signal simulators that mimic the signals you would expect from a real instrument. These
simulators are a powerful tool for Winspect training and demonstrations.

Three different types of signal simulators are available. They are an ultrasonic instrument, an eddy current
instrument, and a point-digitizer instrument. These signal simulators are part of the Winspect demonstration
Workspaces, but they can also be used independently from the Workspace.

See Chapter 4 - Adjusting Instrument settings for more information about using the signal
@ simulators.
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Winspect demonstration Workspaces
These Workspaces demonstrate a complete inspection system, including simulated motors for motion control.
To work with a simulated inspection system, open one of the following Workspaces.

Collecting a B-scan over time without the need for motion control (a time-based scan)

This Workspace demonstrates a rotating scan of a notched tube. It includes ultrasound, eddy current and
external instrument simulations. The Workspace is set up to perform a time-based B-scan of the rotating tube,
collecting waveform, amplitude and time-of-flight data from the A-scan. The simulation also includes eddy
current data.

You can edit the properties of the tube, such as wall thickness and wall thickness variation.

Performing conventional C-scans (a simulated 2-D scan)

This Workspace simulates a 2-D orthogonal scan of a steel block (similar to NDT test standards) in an X-Y
immersion tank system. The Workspace is set up to perform a C-scan of the test block, collecting amplitude
and TOF data.

You can select from three different types of test block.

Collecting C-scan data using multiple transducers (a simulated Multi-Probe scan)

This Workspace simulates a 2-D orthogonal scan of a steel block with flat bottom holes (similar to NDT test
standards) in an X-Y immersion tank system. The Workspace is set up to perform a C-scan of the test block,
using a group of 8 transducers to rapidly collect amplitude data.

You can select from three different types of test block.

A demonstration of Pulse Characterization

This Workspace demonstrates pulse characterization of immersion and contact transducers. The Workspace is
set up to collect the pulse of a transducer and perform an FFT of the captured pulse. Reports can be customized
with company logos and extra information in the headers and footers. The results are automatically saved to a
data file. This demonstration uses a simulated transducer.

You can edit all aspects of this simulation, including the type and characteristics of the transducer.

A demonstration of Transducer Characterization

This Workspace demonstrates a 3-Axis immersion tank system for automated characterization of transducers.
The Workspace is set up to perform four scans to determine the axial (Z) and transverse (X,Y) profiles of the
immersion transducer’s sound field as well as a transverse C-scan. The results are automatically saved to a data
file.

You can edit all aspects of this simulation, including the type and characteristics of the transducer. This
demonstration uses a simulated transducer.
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Chapter 4 - Adjusting instrument settings

The controls for most instruments are grouped under the Instrument Manager. This Winspect component is

active at all times, although it may be hidden from view when not needed for adjusting instruments.

This toolbar button alternately shows and hides the Instrument Manager.

You can also click the menu command: Instruments = Instrument Manager.

Using the Instrument Manager

You can manage multiple instruments with Winspect. Instrument Manager lists all of the active instruments
arranged by timeslots. Winspect acquires data from each instrument sequentially, based on their order in the

timeslot list. This operates much like a hardware multiplex unit.

=¥ Instrument Manager: Timeslot 1 of 3 101 x|

File Instruments Daka

[1 &S can Simulstor =1 [ 2| | -] oisslay |

Digitizer | Signal F'ru:upertiesl Fates I [rata I

A-Scan Simulator Edit Simulation... |

Element Size: Input Peak- Peak:  Sampling B ate: MHurn. OF Awvgs:

E-TORY e R  oomHz =] =l

Pulser
|7I3ain =1.0 | j

Click the and buttons to step through the controls for each instrument in the list, moving one timeslot

at a time.

Click the V¥ button at the right of the indicator box to see a list of all active instruments. Then click on the

instrument you want.

If your instrument is not in the active list for the Instrument Manager, it can be added by two methods:

*  Click the button in the Instrument Manager window. Then select your instrument from the

list of supported hardware.

*  You can also click the menu command: Instruments > Add on the Instrument Manager

menu bar.
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& Be careful about subtracting an instrument from the Instrument Manager list. You will lose all
settings for a deleted instrument. Winspect will ask you to confirm the action before deleting the
instrument. Remember that you can recall a saved Workspace to restore your instrument list if you
make a mistake.

Adjusting Instruments

The Instrument Manager window has a series of tabs to organize the controls that interface to your installed
hardware. Not all instruments will have all the listed tabs. Certain tabs will be present depending upon what
hardware is selected and what features it has.

The Status tab indicates whether Winspect is communicating with the card. This tab may also contain controls
to set the I/O address for ISA cards.

The Signal Properties tab contains information about simulated signal sources.
The Pulser tab contains controls such as voltage, impedance, and pulse modes.

The Digitizer tab groups the controls for digitizer functions such as input channel selection, input voltage level,
sampling frequency, and filter selection.

The Trigger tab contains controls for cards with variable trigger settings. Controls might include trigger level
selection, trigger source, and number of waveforms to acquire per trigger cycle (number of waveforms for
signal averaging).

The Gates tab, which is present on every digitizer interface, lists all of the active gates defined in the A-scan.

The Data tab, which is also present on every digitizer interface, lists all of the data that is to be collected in
each gate.

& Although the Gates and Data tabs contain controls for setting gates and specifying data, these
tasks are much easier to do from inside the A-scan Instrument Display. Right click inside the A-
scan Instrument Display to see this menu.

See Chapter 5 — Defining the source and type of data to be acquired for more information about
@ using Gates and Data controls.

Saving instrument settings

Even though saving a Winspect Workspace saves all of your instrument settings, you may still want to save the
Instrument Manager configuration separately.

Click the menu command: File = Save in the Instrument Manager window to save an instrument configuration
file separately from the Workspace.
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The instrument manager configuration will be saved with a default extension of *.vid. The default folder is
C:\Winspect\Instrument Configurations, but you can save the file anywhere that is convenient to you.

Click the menu command: File - Save As... in the Instrument Manager window to save a modified
configuration with a different name.

Click the menu command: File = Open in the Instrument Manager window to recall a saved instrument
configuration.

Adjusting ultrasonic instruments

Winspect supports a wide variety of ultrasonic pulser-receivers and integrated instruments. Some of these
instruments are cards that go in your computer, and some are external instruments that must be connected via
an interface card or via RS-232 port, but all are controlled the same way within Winspect.

Working with ultrasonic instruments

Click the menu command: Instruments — Pulsers to open a pulser-receiver interface window. When
you select your instrument from the menu, Winspect will open a window with controls configured for that
instrument.

The example below shows the interface for a PRC35 pulser-receiver from JSR Ultrasonics.

Some pulser-receivers have a switch to start and stop the pulser without changing the pulser settings. This is
useful for changing probes or cables. If a pulser is so equipped, its Winspect interface will have a Run button
to start and stop the pulser.

[0l

PRF — Trigger Mode Pulsing——— a

S I?E— &+ Intemal * Pulze/Echo 4””I

L " Extemnal " Piich/Catch Save |
IIZI

— Receiver Gain [dE]

— Dramping e |

| ik j mna

— Filkers —Energy—— Bun
High Pazs Low Pazs
[Mone | |3MHz =l 2w | |

You can minimize the instrument interface window to reduce screen clutter, or close it completely if you have
made all your adjustments. The instrument will remain active at the new settings.

Saving pulser-receiver settings

Although Winspect saves the instrument configuration within the Workspace, you may still want to save the
instrument configuration in a separate file. This can be useful if you use several instrument set-ups within the
same Workspace.
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Click the Save button in the instrument control window to save the ultrasonic instrument settings separately
from the Workspace. Winspect will prompt you for a file name. The file name must have an extension of *.pr
for Winspect to recognize it as an ultrasonic instrument configuration file.

The default location for ultrasonic instrument configuration files is C:\Winspect\Pulsers, but you can store
these files in any folder that is convenient for you.

Click the Open button in the pulser receiver interface window to open a saved configuration for your
hardware.

Adjusting waveform digitizer settings

Ultrasonic waveform digitizers (also called Oscilloscope cards) are configured in Winspect by using the
Instrument Manager.

To make adjustments to a waveform digitizer, first make the Instrument Manager visible by clicking , its
toolbar button. You can also click on the menu command: Instruments - Instrument Manager.

If you have more than one digitizer, scroll through the instruments (Timeslot) list in the Instrument Manager
to select the instrument you want to adjust.

If your waveform digitizer supports more than one channel, you must have a timeslot for each channel, and
configure it as an individual instrument.

=9 Instrument Manager: Timeslot 3 of 5 o ] |

File Instruments Data

3. CompuScope ﬂﬂ j J DiSplayl

Status  Digitizer | Triggerl Gates I [rata I

| CompuScope

Input tode I j' Frequency I j'
Configuration u:uf—l j

[nput Lewvel [nput Type Coupling

! Bl S =]

The most commonly needed controls are grouped on the Digitizer and Trigger tabs. Use these to modify your
settings such as input signal level and source, sampling frequency, and trigger type and source.

36 UTEX Scientific Instruments Inc. ©2004




Winspect User Manual Chapter 4 - Adjusting instrument settings

See the Reference Manual for details about all supported digitizers and their controls.

& Remember that Gates and Data properties are available through the A-scan Instrument Display
with a right mouse click. It is simpler to set up data acquisition using the A-scan Instrument
Display than using the tabs on the digitizer interface.

See Chapter 5 — Defining the source and type of data to be acquired for more information about
@ using Gates and Data controls.

Adjusting all-in-one card settings

Some cards, such as the PCUS 11, have both digitizer and pulser-receiver all in one package. Winspect manages
these cards through the Instrument Manager with a tab for pulser functions and another tab for digitizer
functions.

An all-in-one card is a complete channel from front to back. The same card controls the generation of the
ultrasound energy, the amplification of received RF waveforms, and the digitization of the analog waveform.

The controls for the PCUS 11 card are very similar to those for other ultrasonic waveform digitizers, except that
the digitizer and trigger controls are collected all together on the digitizer tab.

=9 Instrument Manager: Timeslot 5 of 5 101 x|

File Instruments Data

5. PCUS 11 ﬂﬂ j J MI

Status | Digitizerl F'ulserl Dac I Gates I Data I

PC U S 1 1 |N at connected to hardware

Cards detected: 0

Note the DAC tab, which contains the controls for Distance-Amplitude-Correction. This feature is often called
TVG for Time-Variable Gain.
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Adjusting eddy current instrument settings

Several eddy current instruments are supported in Winspect. Two of these are the Eddy Current Technologies
model ECT PC1 Mk II, and the Flare Technologies PD 1000B.

Winspect can also acquire data from an external eddy current instrument by using a single point digitizer.

To make adjustments to an eddy current instrument, first make the Instrument Manager visible by
clicking its toolbar button.

You can also click the menu command: Instruments - Instrument Manager.

If you have more than one instrument, scroll through the instruments (Timeslot) list in the Instrument Manager
to select the instrument you want to adjust.

= Instrument Manager: Timeslot 4 of 5 -100] x|

File Instruments Data

4. Flare PO 0008 [300] ﬂ ﬂ j J Displa_l,ll

— Frequency — Filker
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Balancing

Atteruation = 123
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This example shows controls for a Flare PD1000B card. You activate the controls for this instrument by
highlighting the Flare in the Instrument Manager list.

Through the Instrument Manager interface, you will be able to adjust your probe frequency and balance, and
set filters if they are installed.

Once your adjustments are complete, you can hide the Instrument Manager again by clicking its icon on the
main Winspect toolbar.

=

Remember that all of the instrument configurations are saved within the Workspace.

If you want to save the instrument configuration separately from the current Workspace, you can also use the
File - Save or File > Save As commands in the menu bar of the Instrument Manager window.
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Adjusting single-point digitizer settings
Winspect supports data acquisition cards that accept voltage signals from external instruments or sensors.
These cards can also be used to trigger external instruments and collect data from them.

Show the Instrument Manager by clicking on the main Winspect toolbar.

You can also click the menu command: Instruments = Instrument Manager.

=9 Instrument Manager: Timeslok & of & -10O] x|

File Instruments Data

IE. Unkrown NI Device j ﬂﬂ jJ Displa_l,ll

— Status
Card Type: | Unknown Ml Device  State; | Mot Connected
—Data Collection———— —DataSource———————— — Mode
Mame I Chatnel IEI "I I™ Complex
= B
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If you have more than one digitizer, scroll through the instruments (Timeslot) list in the Instrument Manager
to select the instrument you want to adjust.

Most digitizer hardware supports multiple channels, which can be configured separately. Winspect uses
timeslots to manage each channel as a discrete signal source. You will need to add enough timeslots to configure
all of the channels you want to monitor. You do not need to establish all of the timeslots at once. As you add
sensors, you can add timeslots to configure each new channel.

You can select a voltage input range for each timeslot. You should match this range to the expected output from
the instrument or sensor, in order to get the best amplitude sensitivity.

You can select the signal resolution (8 or 12 bit data). Note that acquiring 12 bit data will double the size of your
data files. Use 12-bit resolution unless you really need to reduce the data file size.

You can set a trigger and post-trigger delay, using digital I/O of the A/D input card. This can be used to “poke”
or trigger an external instrument to send its data.
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There are some advanced features of the single-point digitizer interface:
* Data pipeline: Some instruments, (e.g. Krautkramer USD15) transmit their data from gated
signals one or more trigger cycles after the waveform is acquired. The Data Pipeline setting is
used to synchronize Winspect with external instruments that use this form of data output.

e Complex Data: Winspect can acquire both X&Y voltage components from an external eddy
current instrument, and manage this as a single complex channel. Adjacent physical channels
act as input pairs for the external instruments.

Acquiring eddy current data with a single point digitizer

You can acquire data from any eddy current instrument (even if Winspect does not support it), by using a single
point digitizer. You control your instrument manually through its front panel, and Winspect will acquire the
X&Y voltage signals through the single point data acquisition card.

9 Instrument Manager: Timeslot 1 of 1 o ] feA |

File Instruments Data

I'I. Data Translation DT2838 (300] ﬂ ﬂﬂ J Display |

— Flesolution
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I
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All single-point digitizers supported in Winspect can be configured to read complex data from eddy current
instruments. In the example above, a Data Translation DT2838 card is being used to acquire eddy current data
from an external instrument.

Check the box beside “Complex Data” to configure the card for eddy current data acquisition.

Each pair of inputs on the DT2838 card is connected to the two voltage outputs of the eddy current
instrument.

Channel 0 is the X voltage (real component), and Channel 1 is the Y voltage (imaginary component). Channels
2 and 3 are paired in the same way, and so on.

Several eddy current instruments can be recorded with one digitizer card.

When a digitizer timeslot has been configured to acquire complex data, you can use the Eddy Current
Instrument Display to observe, record and analyze the signals from your external instrument.
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Adjusting signal simulator settings

Winspect provides software based signal simulators. They are configured through the Instrument Manager,
just like a physical instrument. There are two simulators: one for ultrasound signals (the A-scan Simulator),

and one for single-point signals (the Point Digitizer Simulator).

Show the Instrument Manager by clicking on the main Winspect toolbar.

You can also click the menu command: Instruments - Instrument Manager.

Adjusting the A-scan Simulator

You can add the A-scan Simulator as an instrument.

Click the button in the Instrument Manager window to add a Timeslot, and then select A-scan Simulator

from the list of supported instruments.

=9 Instrument Manager: Timeslok 1 of 3 10 x|

File Instruments Data
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The A-scan Simulator operates exactly like a physical instrument, and it can be configured for a variety of

demonstration and training purposes. Here are some of the things that you can adjust:

Digitizer Controls
»  Select the signal resolution from 8, 12, or 16 bit data
*  Select the signal input Range in volts.
»  Select the digitization rate (sampling rate) of the simulated signal.
» Select Signal Averaging and set the number of averages.
*  Select the pulser gain.
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Ultrasonic Signal Properties
e Define the center frequency and bandwidth.
* Add noise to the signal in various levels.
* Select the pulse type (Normal, Chirp, or Golay encoded), and set the properties of each type.

Click the Edit Simulation button to reveal the simulation controls.

See below for instructions about using these controls.

Adjusting the Point Digitizer Simulator

You can add the Point Digitizer Simulator as an instrument.

Click the button in the Instrument Manager window to add a Timeslot, and then select Point Digitizer
Simulator from the list of supported instruments.

& Instrument Manager: Timeslot 2 of 2 =10] =l

Eile Instruments Data
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The Point Digitizer Simulator operates exactly like a physical instrument, and it can be configured for a variety
of demonstration and training purposes. Here are some of the things that you can adjust:

Data Collection

* Name the channel. This name is shown as a title in the instrument strip chart display, and in the

saved data file.
*  Select whether the data is collected while scanning, or simply displayed without being collected
or saved.
Data Source

You can select whether the data is simulated as eddy current signals, or as a single-point signal from an external
flaw detector instrument.

Click the ¥ arrow to select a simulated data source.
. Select Wall Thickness to simulate a measurement signal from an external flaw detector.

. Select Eddy Current to simulate eddy current signals.

You can select whether the data is displayed in 8, 12 or 16-bit resolution.
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You can add simulated noise to the signal.

Click the Edit Simulation button to reveal the simulation controls.

See below for instructions about using these controls.

Editing the simulation

The simulated A-scan and point digitizer signals are derived from a simple model of a real inspection, such
as a tube scan, test block, or transducer characterization system. You can edit many of the parameters of this

simulation model.

Click the Edit Simulation button to reveal the simulation controls.

Type:
Click the ¥ arrow to select a simulated object or
inspection type.

Select Axes:

Click the ¥ arrow to link the simulated scan axes to
a dimension of the simulated object.

Only those axes already listed in the Motion
Controller will be available for selection in this
window.

Probe position:

In the Tube Simulation, you can adjust the probe
offset, to simulate a poorly centered probe inside the
tube.

Dimensions:

Type: ITube
— Select Azes

iz 1

— Probe position [mm)

Qff-center

I 1.000000

2|
Tube Dimensions [mm)
Thickness IM
Thickness Yariation ID-U5UUUU
[Em)

Outer Diamneter

=101 ]

AXIS 1

-

You can edit the dimensions of the simulated object, including the depth and type of “defect” included in the

object model.
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Chapter 5 - Defining the source and type of data to be acquired

This chapter describes how to define the type of data you want Winspect to acquire. It is divided into three
sections: Collecting ultrasonic data using gates; Collecting data from point digitizers, and Collecting eddy
current data.

Collecting ultrasonic data using gates

Gates are tools for looking at portions of an ultrasonic waveform and defining the data to be extracted from that
waveform.

Understanding gates

Ultrasonic signals contain a vast amount of information about the materials through which the sound energy
has passed. Even a simple A-scan contains a waveform with many features. To use any of this information, you
must specify the data to be acquired from the ultrasonic signal. The first step involves setting a gate around the
area of the signal that interests you.

For example, to determine the thickness of a material, you would place a gate around the back wall echo of the
A-scan, and specify Time-of-flight (TOF) as the data to extract from that gate. If you know the sound velocity
for the material, you can calculate the thickness. Winspect can perform these calculations automatically.

See Chapter 10 — Processing the data to improve its usefulness for more information about
@ using automatic calculations in Winspect.

In other applications, such as flaw sizing, you may want to know the amplitude of a particular echo.
You must gate this echo to identify it, and specify that you want to know its amplitude.

Setting gates on the signal

The Right-click menu in the A-scan Instrument Display is the best way to set gates and define the data that is
to be extracted from the gated portion of the signal.

* To add a gate: Click the " button on the A-scan Instrument Display toolbar.

*  To move a gate: Move the mouse over the left edge of the gate. Click and drag the gate to a
new position.

» To re-size a gate: Move the mouse over the right edge of the gate. Click and drag the gate to
change its size.

* To change the threshold: Move the mouse over the horizontal bar of the gate. Click and drag
the bar to raise or lower the threshold value of the gate.

» Toremove a gate: Right-click inside the A-scan instrument display. From the pop-up menu,
select Remove Gate. Select the gate you want to delete.

* To change gate properties: Right-click inside the A-scan instrument display. From the pop-
up menu, select Gate Properties. Select the gate you want to modify.

The gate properties menu is most useful for changing the name of a gate, or for specifying an interface trigger
source for the gate. Gate start position, span, and threshold values are more easily set using the mouse directly
inside the A-scan Instrument Display window.
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You may want to use the Gate Properties menu to name the gates, instead of using gate numbers. In complex
signals this can clarify what part of the signal is gated, and how it relates to the actual object being inspected.

Specifying data to be acquired

The Gate Properties window allows you to

specify the data to be acquired from the gate B
such as peak amplitude, time-of-flight (TOF), ~Gate Posion———————————— ~Definable Data Types——————————

etc. Mame: ||F Choices:
Agcan dmplibude
Delay: I22 UsEC

tdatlab 10 Proceszor

Winspect allows you to collect multiple data Range: [0 usec Peak Pasition
7 3 Single Point
types from a single gate. If you select multiple S IDE— i il

1 Level Crozzing Fonward
data types, each data type will be recorded as a oo ST Coferanes N
subset of the data file. trigaer gate:

Y Add
—Standard Data Typee————— WV

Click any number of check boxes beside the mplituds: Abs. Valie s
[ JAmplitude: M asimurn Peak Center Position
data types you want to collect. Jamplitude: Mirimum

[w] TOF to Threshold
[ITOF to +ve Peak

Winspect can extract many types of data from a LITOF to -ve Peak

] (v avefarm
gated signal; several of the most common types
are listed in the Gate Properties window. Froperties... Delete
Claze I << Less

Winspect can collect single-point data, or it can
collect the entire waveform within the gate.

@ See the summary table at the end of Chapter 6 to learn how Winspect displays data based on the
data source and type.

Using advanced data types

In addition to the standard data types, you can collect any number of advanced data from the waveform. These
data types are listed in the extended Gate Properties window.

Click the More >> button on the Gate Properties window to select from additional data types.
Click on the name of the advanced data type you want to collect, and then click the V Add button to add it to the
Selected list at the bottom of the window.

You can add as many advanced data types as you want.

Most advanced data types have Properties that control how the data will be collected. To edit the properties
of an advanced data type, you must first add it to the Selected list.
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. - . .ol

Click on the data type in the Selected list B PesitiE 0 ]
. . . . - - Base P S A

to highlight it. Click on the Properties Cevelind |5 .:‘ ave s |

button to reveal the properties window for Frint |

that data type. oK |

2

In this example, Peak Width is calculated at -6 dB down from the point of maximum amplitude

See the Reference Guide for a listing of the advanced data types that are available.
@ See Chapter 10 — Processing the data to improve its usefulness, for information about using
advanced data types to perform signal processing on live data as it is collected.

Using interface trigger

The interface trigger is used to automatically reposition gates based on a specific echo in the A-scan. It is useful
in situations where you want to start data acquisition at a specific feature of the waveform, or when you need
to track echoes that are moving due to changes in water path, material thickness or sound velocity in curing
materials.

Without an interface trigger, —
.. . T Inst t Displ —|O] =
e o ol

File Instrument Gates ‘Wiew Update Range Tools Window

gate will not move if the echo

moves. HE E- 20+ LERe 4|&S|EIC
A-Scan Simulator Time Slot 1: s
You must have at least two | -
gates on the A-scan in order s I 1
. . i i -} -*

to use an interface trigger. e -
One gate triggers another gate, Ao
when the signal crosses the s -
threshold of the interface gate. i BV
The screen capture opposite S 25 i
illustrates how this works: s L -

& £ 10 1= 0 i 30 3= 40 45 -

This A-scan shows a front 0 Time {usec)
wall, and several back wall. 2008

Gate one (labeled “IF”) has been configured as the interface, and gate two has been labeled “BW” for back
wall.

The signal crosses the threshold (0.6 V) of the interface gate at about 26 ps.

The BW gate is configured to start at 0.5 ms after the interface gate is triggered, which is 26.5 ps in this
example.

If the front wall echo moves due to a change in water path, the BW gate will also move to maintain its position
relative to the front wall.

If the threshold of the interface gate is not crossed, the second gate will not appear in the A-scan
because the echo in the interface does not trigger it. Undefined data will be recorded at that location
if you are scanning.

=
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Viewing live data collected From gates

Use the Point Data Display if you want to display the live data as it is collected in a gate. All of the gated data
is collected during a scan, regardless of whether it is shown in a Point Data Display. However, it is sometimes
useful to have a live display during the scan

See Chapter 3 — Viewing Live Signals for more information about using the Point Data Display.
@ You can also view data as it is collected in C-Scan mode. See chapter 7 - Setting up the scan.

Collecting data from single-point digitizers

Data from single-point digitizers does not need to be gated to be collected. An instrument or sensor has already
reduced it to a single value. The value is expressed as a voltage level on the selected input channel. Winspect’s
Instrument Manager records the voltage from each input channel.

If you are using a single-point digitizer to record output from an external instrument, the instrument may already
have performed some data reduction by gating a complex signal and extracting a data point. For example, the
Krautkramer USD-15 flaw detector has gating functions, and can output the Time-of flight within a gate as a
voltage level.

Each input channel on the point digitizer is represented by a single timeslot in Winspect. Winspect steps through
the timeslots sequentially to acquire data from each channel in turn. To acquire data from eight input channels,
you must have eight timeslots defined.

The data from each timeslot is recorded as a subset in the Winspect data file. If you have eight timeslots defined,
you will generate eight data subsets in the data file.

@ See Chapter 4 — Adjusting instrument settings, for instructions on setting up timeslots.

Data pipelining
Some NDT instruments output data that was acquired several trigger cycles before the current trigger. This is
called data pipelining.

Data collected from such an instrument will not be synchronous with the current position of the scanner or with
data from other instruments. The data will be recorded in the wrong position in the scan.

Winspect corrects this by compensating for the number of trigger cycles the pipelined instrument lags the
current trigger. If your you have such an instrument, and your C-scan image shows significant backlash, you
may need to adjust the data pipeline setting to synchronize Winspect with the external instrument.

@ See Chapter 4 — Adjusting instrument settings, for information about adjusting single point
digitizers.
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Collecting eddy current data

Winspect can collect data from eddy current instruments in two ways. Card based instruments such as the
ECT- PC1 MK II or the Flare PD1000B are managed directly through the Instrument Manager. Data from other
instruments is acquired with a single point digitizer card, such as the DT21 EZ or National Instruments MIO
series cards.

Using supported instruments:

Each instrument occupies its own timeslot in the Instrument Manager. Winspect records the paired eddy
current (X&Y) information for each timeslot as a single data subset. If you have more than one eddy current
instrument, Winspect automatically creates a new data subset for each timeslot in the instrument manager.

See Chapter 4 — Adjusting instrument settings, for more information about setting up these eddy
@ current instruments.

Using single point digitizer cards with external instruments

With an external instrument, you must use a data acquisition card to obtain the eddy current data. The X&Y
voltage outputs from the eddy current instrument are collected as analog voltages on two adjacent channels of
a single point digitizer card. Winspect manages these two inputs as a single complex channel.

Complex Data is selected for the card = Instrument Manager: Timeslokt 3 of 3 10| x|

in this Timeslot so the input channels “g " b popg

are paired and Winspect treats them as — _
a single data set. Winspect collects the [3.N1 6025 Digitizer El ﬂﬂ jJ M

X (real) voltage on one channel and

. — Statuz
the Y (imaginary) voltage on the next
. Card Tupe: | NI 6025 Digitizer State: | Mot Connected
sequential channel.
—Data Collection———— ~ DataSource—————— — Mode

As with supported instruments, Namel Real [] ||:| v'I ¥ Complex

Winspect records the paired eddy : : V¥ Bipalar
. . [ Collected while zcannin i I v'I ) :
current (X&Y) information for each 9| | Imaginary [¥] |1 [v Differential

timeslot as a single data subset. If you i

have multiple external instruments, Input Fange I +/5.00 'I Yalts SignaIMa:-:imuml B olts
you must configure a Timeslot for

each instrument in the Instrument ZEballl m Sl i I SRR
Manager. A 16-channel digitizer card
can support up to eight external eddy
current instruments.

See Chapter 4 — Adjusting instrument settings, for more information about setting up the data
@ acquisition card.
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Chapter 6 - Selecting a scanning method

The scanning method you select will depend upon what equipment you have, and what type of data you want
to collect. Here, we discuss one-axis, two-axis, and time based scans.

For information on other types of scans, such as three dimensional scanning, Multi-Probe scanning, or Tansducer
Characterization, refer to the appropriate appendixes or manuals.

See the chart at the end of this chapter for an outline of Winspect scan types and how the corresponding data is
displayed.

Selecting a scan type

There are two ways to specify a scanning method:
In the Winspect main toolbar, a selection box shows the current scan type:

Click the ¥ arrow at the right side of this box to see the
list of available scan types.

%‘ IPnint by Paint Scatning j

Click on the list to select the type of scan you want to i % =
perform.

You may choose from 1 Axis Scanning, 2 Axis Scanning, 3Axis Scanning, Timed Scanning, Point by Point
Scanning, 1 Axis Multi-probe and 2 Axis Multi-probe (with the additional Multi-Probe component of Winspect),
and Transducer Characterization (with the additional Transducer Characterization component of Winspect).

You can also click the menu command: Scanning - Scan Type in the Winspect main menu bar to see the list
of available scan types. Click on the list to select the type of scan you want to perform.

Scanning with one axis

Use a 1-axis scan to collect information along a distance or around a circumference. Scanning with one axis
will produce either a graph or a B-Scan image. Graphs are produced when collecting single point data such as
Time-of-Flight. B-Scan images are produced when collecting RF waveforms along an axis.

Select a 1-axis scan if you need to:
* Scan a pipe along the length (perhaps for testing thickness).
*  Scan a cylinder or tube around the circumference.
*  Scan a weld line from one side.
* Scan a bond line between two materials.

Click the ¥ arrow at the right side of the scan type box to see the list of all available scan types.
Click on the list to select: I Axis Scanning.

You can also use the menu command: Scanning - Scan Type - 1 Axis Scanning on the Winspect main
menu.

@ See Chapter 7 — Setting up the scan for information about adjusting the scan parameters.
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Scanning with two axes

Use a 2-axis scan to collect information in an area. The area can be defined by 2 linear axes (X and Y distance),
or by one rotary and one linear axis (rotation angle and distance).

C-scan images are produced by capturing a single point of data (such as amplitude or time of flight), for
every point in a two-axis scan. Capturing the RF waveform for every point in a two-axis scan produces a 3-
Dimensional C-scan image. Winspect has advanced tools for viewing 3-D C-scans.

Select a 2-axis scan if you need to:
* Scan an entire surface such as a flat plate or sheet (make a C-Scan).
*  Scan a section of pipe or vessel along the length and around the circumference (also a C-scan).
* Scan an object in an immersion tank with a turntable and elevation arm.

Click the ¥ arrow at the right side of the scan type box to see the list of all available scan types.
Click on the list to select: 2 Axis Scanning.

You can also click the Scanning - Scan Type = 2 Axis Scanning command on the main Winspect menu
bar.

@ See Chapter 7 — Setting up the scan for information about adjusting the scan parameters.

Scanning with three axes

3-axis scanning is possible in Winspect, although it is rarely used. It is sometimes called volumetric scanning.

A 3-axis volumetric scan is really a set of C-scans stacked one on top of the other. A C-scan is completed for
each layer with a normal 2-Axis scan. Then the third axis is stepped up, thereby changing the focus of the probe
to correspond to the next layer.

Using timed data collection

Time based scans can be used to monitor a continuous process, or to observe changes in material properties over
a period of time, such as reaction, curing, or adhesive setting.

Time based scans are also used to scan without motion hardware. A practiced operator can produce scans of a
small area with excellent resolution, by moving the probe manually with a steady hand.

Timed scans are similar to one-axis scans, but elapsed time is the measured axis instead of distance traveled.

Select a timed scan if you need to:
* Inspect an area manually, moving at a constant rate.
* Inspect a material as it is extruded in a continuous mill (e.g. pipe thickness, polymer property
monitor).
* Observe a stationary sample for changes in time, such as curing, bonding, etc.

Click the ¥ arrow at the right side of the scan type box to see the list of all available scan types.
Click on the list to select: Timed Scanning.

52 UTEX Scientific Instruments Inc. ©2004




Winspect User Manual Chapter 6 - Selecting a scanning method

You can also click the Scan = Scan Type - Timed Scanning command on the main Winspect menu bar.

@ See Chapter 7 — Setting up the scan for information about adjusting the scan parameters.

Point by Point Scanning

Point-by-Point Scanning is a scan type that when in Manual Mode, enables you to collect and arrange data
without needing any equipment to manipulate the probe or track its position. You use Point-by-Point Scanning
to build an image of the scanned area by following a grid marked on the object, which is then mapped to a data
array within Winspect.

Typical uses for this type of scan include: manual inspections of repaired damage areas, corrosion mapping, and
rapid inspections of suspect regions to determine whether set-up of a motorized scan is warranted.

You can also use Point-by-Point Scanning in a Motorized Mode. When in Motorized Mode, Winspect uses
assigned motion axes to move the probe to the designated grid positions and collect the data.

Using external motion control

Winspect is capable of “going along for the ride” on a machine that is externally controlled. In this mode,
Winspect does not control the movement of the scanning head. The scanning equipment is controlled by another
system, while Winspect manages only the data acquisition tasks.

There are three main points to remember about using external motion control:

1. At least one axis must be configured for external control. The Motion Controller will display
only the position readout, without Jog or Forward/Backward buttons.

2. An external machine or the operator moves the axis. Winspect records encoder position
information.

3. Scanning must be terminated manually by pressing the <space bar> or <Esc> key.

You might use an externally controlled scan when:
* An existing machine controls the scanner with encoders. Winspect can use these encoders to
determine probe position and record data.
*  Your scanner performs complex surface following. These machines usually provide position
information or a trigger to Winspect, which then acquires data.
*  You perform a manual scan, in which the operator moves the probe, and an encoder provides
position information to Winspect.

You must still select a scan type to define how Winspect will organize the data. The selection of external motion
control just indicates that Winspect will be passively acquiring data, rather than driving the scanner.

Click the ¥ arrow at the right side of the scan type box to see the list of all available scan types.

Click on the list to select the type of scan you want to perform.

You can also click the menu command: Scan = Scan Type in the Winspect main menu bar to see the list of
available scan types. Click on the list to select the type of scan you want to perform.

@ See Chapter 8 — Performing the scan for more information about options for externally controlled
scans.
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Chapter 7 - Setting up the scan

Once you have selected a scan type, you will need to specify some scan parameters, including scanner control
and data collection options. In this chapter, we will outline how to do this.

The scan configuration options available to you will be based on the motion controller configuration.

Using the Scan Controller

The Scan Controller is always available, and can be hidden or revealed at any time.

Click the ﬁﬁ

You can also click the menu command: menu selection Scanning - Scan Controller.

icon on the Winspect main toolbar to reveal the scan configuration editor.

Click again to hide the scan configuration editor.

The Scan Controller has tabs that group the controls for:
*  Defining the basic scan pattern and speed
*  Specifying additional motion options
*  Specifying data collection options
* Evaluating scan performance

You will need to specify the motion parameters for your scanning system, unless you are using an externally
controlled scan, or a timed scan.

See Chapter 2 — Manually controlling the scanner for information about moving the scanner to
@ a home or start position before beginning a scan.

Selecting which axes to use

The Scan tab on the Scan Controller is used to define the basic scan pattern. The first step is to specify how
each axis will move during the scan. Only those axes that have been configured in the Motion Controller will
be available for selection. =

= 2 Axis Scanning x|
For example, if your motion controller
has two linear axes, your choices
might be X and Y, as shown opposite.

Scan |EI|:uti|:|ns| Enllectiunl F'erf-:urmanu:el Shapel

— Scan Az — Index Auxis

[i< s =l |7 s =l
Some specific terms are used to Liesils |_1 0 o Ll |_1 0 ‘.
|1 i

describe the scanner motion:
R ezolution I'I i R esolution

Scan Axis: The main axis of motion, coeed I-I— S S |1 o

along which the scanner will move

continuously. Each pass along the Continuous ratation Helicallindexing ™
scan axis builds a row of data in the
image file. Aol | e |
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Index Axis: The secondary axis, along which the scanner moves incrementally after each pass along the scan
axis. The index axis parameters define how the rows of data are spaced.

Step Axis: For 3-axis scans, the step axis is the elevation axis. This is usually labeled Z, and operates like the
index axis. The Step Axis controls are on a separate tab, which is only visible when 3- axis scanning has been
selected as the scan method.

Using Rotary Axes

When using a rotary axis as the scan axis, you can specify that the scan and index axes move continuously. This
can significantly reduce the time required to perform a scan.

The default mode is that the axes stop at the end of each programmed movement, similar to linear axes.

[= 2 Axis Scanning x|

Scan |Dptiu:uns| I:::ulleu:ticunl F'erf-:urmanu:el Shapel

If neither of the continuous motion
boxes is selected, the scanner

S P motion is reciprocating. Winspect
i s 4 EH_ & scans the turntable the number of
IT“’”ta':"E = Iz’i\*""S d degrees specified in the scan axis
Length, then indexes, and repeats the
Length 360 deq Lergth |1 0 i ’ ’
turntable scan.
R ezalution |1 deqg R ezalution |1 T
I— If Continuous rotation is checked
Speed |1 deq/sec Speed 1 mmy/sec .
for the scan axis, the turntable
Continuous rotation [ Helical indexing revolves steadily at the rate specified
in the Speed box.
Apply | Cloze

Winspect acquires data for the angle
specified in the Length box.

If Helical indexing is selected, Continuous rotation is activated automatically, and Winspect performs a
helical scan.

Defining the size of the scan

Enter the desired length of the scan in the Length box on the Scan tab. You must also specify a travel distance
for the index axis.

Remember to account for the starting position of your scan when entering each axis length. The length you
define for each axis must be smaller than the physical length of the axis. Other physical limitations such as limit
switches, tank walls, etc. will also affect the maximum axis length you can define.

When using a rotary Scan axis and Continuous rotation is activated, you can specify a Scan length of less than
360 degrees. The axis rotates continuously, but Winspect will acquire data only during a part of the rotation.
This produces a pie-shaped scan of a disc, or a rectangular scan of a cylindrical section.
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Defining the sample interval
Enter the desired spacing of your data in the Resolution box on the Scan tab.

Scan resolution defines the spacing of data samples. A small resolution number will produce a fine image; a
large resolution number will produce a coarse image. Use a resolution just small enough to show the necessary
detail that is required for your application.

There are three complications that can occur if you set extremely fine resolutions for the scan:
e A smaller resolution will increase the size of the data file. A scan with resolution of 0.1mm X 0.1 mm
has a data file 100 times larger than the same scan at 1 mm X 1 mm resolution
e If your resolution is too small on the Scan axis, data may be missed, especially when scanning at
high speeds.
e If your resolution is too small on the index axis, the scan time will be extremely long.

It is typical to specify a resolution that is approximately 1/3 of the minimum rejectable flaw size. This ensures
complete coverage of the scan area, with at least three samples taken over any potential flaw of rejectable
magnitude.

The sample interval can be different for the scan and index axes. Winspect has tools to render the scan image at
1:1 scaling, even if the data was not collected with equal resolution on both axes.

This will be discussed in Chapter 9 — Viewing the data.

Defining the scan speed

Enter the desired travel speed for each axis on the Scan tab. The units will be in in/sec, mm/sec, or deg/sec,
corresponding to the way your axis is defined in the Motion Controller.

Remember that the maximum travel speed for each axis is set within the Motion Controller configuration.
Winspect will prompt you with an error message if you specify a scan speed greater than the allowed
maximum.

If you are using a very fine resolution for detailed imaging, you may have to reduce the scan speed
significantly, in order to scan without missing data.

Specifying scan motion options
x| Use the Options tab to modify the scanner’s
motion behavior. For example, you can specify

Sean  Oplians | Colectian| Perfomance | Shage | that the scanner pauses after each scan line,

[L1 %120 Deicis sachizcaning RouEseen returns to the start position at the end of the scan,
] Stop on defect IDE'— K K i

[] Rieturn ta start after scan ’ or scans in one direction only.

] Unidirectional data collection

[ Zero encoders before scan — Backlazh remaoval:

] Confirm before zeroing encoders .

[ Dar't index half pixel an start |'3' Click on any number of check boxes to select
] Scan will be centered on start position

your scan options.

Apply | Cloze |
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Overscan length is the distance that Winspect will drive the scan axis beyond the length you defined on the
Scan tab. This feature compensates for any mechanical play in the scanner drive system, and ensures that the
scanner collects the last data point on the scan axis.

If your scanner stalls at the end of each scan line, you may need to increase the Overscan length.
If your scanner has significant backlash, the scan image will have scan lines that are offset in alternating rows.
There are two ways to correct this:

Checking the Unidirectional data collection option may improve the image quality.

or...
Setting a Backlash removal amount. Every other row will be offset by the amount in this box to re-align the
image.

@ See the Reference Guide for detailed definitions of each option on the Options tab.

Specifying data collection options

Use the Collection tab to set up the

data collection options for the scan. i 2 Al SEau =

. Scan I Options ~ Collection | Perfarmance I Shape I
Click on any number of check boxes

; [] Beep when scan completed
to select your scan options. [] Sawe data prompt when zcan completed
[ “write b file duning scan
[ " arn before ovenariting data
[] Resave data on scan start

The Low PRF mode feature is ] Append coordinates to comment
: [] Reszcan uzing previously collected data
us'eful if _your hardware cannot E] Low PRF mote [1 trigger per pival]
trigger rapidly (e.g. EMAT systems), [ Live displays during scanning _
or if you experience wrap-around of [] Use auto-filenaming EaCoulio) I:”:'t":m|
the ultrasonic signals in the material | Auto Filenames |

being inspected.

Apply I Cloze |

@ See the Reference Guide for detailed definitions of each option on the Collection tab.

Using automatic file naming and saving
Winspect can save data files automatically at the end of a scan. You must specify a root filename for Winspect
to use when you enable this feature.

Click the Auto Filenames button on the Collection tab in the Scan Setup window.
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Winspect will prompt you to provide additional information.

Winspect will save scan files automatically, using the root name with a numerical suffix. Try to use a meaningful
file name as the root, so that it describes what is in the data file. This will help you locate important files

easily.
x
Each new data file will be assigned a sequential = [~ Epable futo-Filename Generation
number, starting with the Index you specify.
[T Confirm Filename Before Use Cancel |

You can set Winspect to confirm the automatic filename [ Automatically Save Data after scan completed
before it saves the scan data.

Mames
The default file extension is always *.sdf for Winspect Root: [FILE Index: I':'
data files. This is applied automatically, and you do not eq. weld005. sdt
need to specify it in the Root file name.

Determining when the scan will complete

The Performance tab shows helpful information such as the estimated time to complete the scan, and resulting
data rate based on the selected scan speed. This information is calculated from the settings on the Scan tab.

The Test Speed button calculates the maximum speed at which Winspect can scan without losing data. This is
calculated based on the number of timeslots in the Instrument Manager, and the time required to collect data
from all of these timeslots.

Click on the Use Maximum button to use the calculated maximum rate for the scan. Winspect will update the
Scan Speed settings on the Scan tab automatically.

. [=si 2 Anis S i .o

than the maximum speed allowed

) j ] . Scan I Dptiunsl Collection Performance | Shapel
for your axis, Winspect will advise

you of this, and set the scan speed to Selected Speed: [1 in/sec Test Speed |
the limit defined for that axis in the Fesulting D ata B ate: 1.000Hz Wiz [ ssmun |
Motion Controller configuration. Time to Completio: B .

Last Hit Count |

. Scan Completion at: 10:30 Ak
The Last Hit Count button calculates _ Detailed Test |
. b aximurmn Speed:

the performance of the previous
scan in terms of the percentage of Mawimum D ata Fate:

data points acquired relative to the
number of points that were defined
for the scan.

Apply Cloze
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Saving and retrieving scan definitions

Saving a Workspace file also saves the scan definition as part of the Workspace.

If you wish to save the scan definition separately, you can use the menu command: File - Scanning - Save
on the Winspect main tool bar.

If you want to save a modified scan configuration with a new name, use the menu command: File = Scanning
- Save As, and Winspect will prompt you to enter a filename.

Winspect uses the file extension *.scn to recognize scan definition files.

To open a saved scan definition, use the menu command: File = Scanning - Open on the Winspect main
tool bar.

Unconventional scan patterns

You can specify a non-rectangular [EEPYEF—— |

area when performing a 2-Axis scan.

ThlS feature iS minimizes the scan Scan I I:Ip[igngl ED”EDHDHI Perfarmance Shapel
time for large objects, because it —Chooze shape—————————— - Define relative pozitions
eliminates the time wasted scanning e j . .

_ ) | circular Start. (0,000 in,0.000 in]
regions that are not of interest to A (10,000 in,10.000 in]

you.

4]
=
M

rig
The default shape for a 2-axis scan is

a square or rectangular region. You ; L
can also define a circular, triangular, start
or trapezoidal shape for the scan. el =,

index:

NE
4

HOTE: Pogsitionz are relative. Scans
alwaypz ztart from the curment pozitian.

@ See Chapter 6 - Selecting a scanning method to learn about selecting a scan type.

To scan a non-rectangular area, you must select a 2-axis scan type, and then modify the shape of the scan area.
Defining the basic shape
You must first define the size of the scan area exactly the same way you would define a conventional scan, by

specifying the dimensions on the Scan tab.

The Shape tab has the controls you use to define the shape of the scan area. The scan shape is displayed in the
window. Rectangular scanning is the default shape.

Click the ¥ arrow and select Circular or Trapezoid from the list. Observe carefully to see which is the scan
axis and which is the index axis.
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Select Trapezoid Scan or Trapezoid Index to match the orientation of the object or region you wish to
scan.

)

Click the button to rotate the scan shape. Note that this rotation changes the relative start and end points,
and the direction of the scan. It does not affect which axis is used for scan or index.

Defining the shape dimensions

You must specify two or four vertex points to define the dimensions of the scan shape.
» Two vertices are needed to define circles, and rectangles.
*  Four vertices are needed to define trapezoids and triangles. A triangle is simply a trapezoid
which has two vertices defined with the same coordinates.

If you have already defined the scan and index axis lengths on the Scan tab, these limits will be suggested as
default vertices that define a rectangular shape. You must edit these vertices to control the shape of the scanned
area. There are two ways to specify these points.

1. Click on a vertex in the list, and then click the button to edit its coordinates.

2. Drive the scanner to a position, click on a vertex, and then click the E button to capture the
current position and record it for the current vertex.

& The positions you define are relative. The scan pattern is calculated from the current position of the
scanner in (X,y). You must return to the start point BEFORE you start the scan.

Click the El button to drive the scanner to the selected vertex. This works exactly like the “Go To” command
in the Winspect Motion Controller window.

When setting up a scan for the first time, it is good practice to manually drive the scanner to each vertex. This
will help you ensure that:

* The defined scan area is sufficient to cover the region or object to be inspected.
* The directions for scan and index axes are correct.
e The defined start point is correct.

It is strongly recommended that you save the scan definitions and their Workspaces, once you have developed
a reliable scan pattern.

'2 Caution! Take appropriate care when defining your scan shapes. If you incorrectly define the
shape, the scanner can move in unexpected ways. It is possible to collide the scanner with the part
under inspection, or with supports or tank walls.

Ensure that limit switches are present and working properly on all axes, and that the entire range of scanner
motion is clear of equipment and personnel before starting any movement.
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Setting up a Point-by-Point scan

To set up and perform a Point-by-Point scan, you must define the Scan type, and open the Scan Controller

window.

Click the ¥ button beside the Scan type indicator box, and then select Point by Point Scanning from the

list.

Click the ﬁﬁ on the Winspect Main toolbar to open the Scan Controller window.

On the Define tab, you must specify the dimensions of the data
array and indicate the number of data points. In Manual Mode,
this must exactly match the grid you have laid out on the actual

Define | Dpfians | Collection |

Number Of Axes |2 Vl

== point by Point Scanning

Mode IMUlDfiZBd vl

Horizontal

Wertical

. . [ ~ | | 5|
are? to be.lnspected-. If you seles:t Motortzefl Mode, your rpust . o o [—
assign available motion control axis to the horizontal and vertical. 00 O
The scanner must be able to reach the extents of the assigned S (e O | P

grid.

You must also specify the spacing of data points in the array. Normally, this will be either in units of length:
mm or inches. You can also use encoder counts, or a non-dimensional unit called “columns” for more versatile
data collection. Winspect will organize the data points according to this grid specification.

The Collection tab includes options to control how scan data will be saved, and whether data can be
overwritten when repeating a scan. These controls are useful if you will be doing multiple scans with the same
basic definition.

Using on-line data display while scanning

You can view the scan image as the scan proceeds. This will allow you to judge whether the scan is proceeding
correctly, and make any necessary adjustments before completing a whole scan.

Both Line Plot and Color Plot displays can be configured to show on-line data as it is acquired.
If the displays are not already configured, please refer to Chapter 9 - Viewing the data for information about
how to set up the image viewer to display on-line data.

Winspect updates images for 2-Axis and 3-Axis scans at the end of each scan line, while the scan indexes for the
next scan line. This ensures Winspect is not busy updating a display when data needs to be collected.

For 1-Axis, Helical, and Timed Scans, you must specify a display update interval in the Scan Controller. Click
the Collection tab to edit the display update interval.

Using a rapid update rate can cause loss of scan data because the host computer will be busy updating images
instead of collecting data. Use the longest image update interval you can tolerate, to avoid this problem.

To perform very fast 1-Axis, Timed or Helical scanning, you may have to disable the live image update feature.
Click the Collection tab to display the options box, and remove the check mark from the box beside Live
displays during scanning.
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Chapter 8 - Performing the scan

Once your scan is configured, you are ready to begin the scan and acquire data.

Clicking the g button on the Winspect main toolbar starts most scans. What happens next depends upon
what type of scan you are performing. All scan types can be paused, stopped, and restarted.

The clock keeps running for timer-based scans that are paused, only without data collection taking
place.

For example: If you pause a timed scan, and restart, you will have a region in the scan image that is without
data.

Performing a manual scan

Click the g button and move the scanner. Encoders will follow your motion and Winspect will record the
data in to memory as you go.

Press the <Esc> key or space bar at any time to pause the scan and view more options.

@ See Options for externally controlled scans later in this chapter.

Stop the scan by pressing the <space bar> or the <Esc> key.

Performing a motorized scan

Click the g button. Winspect will move the scanner according to your scan set-up and record the data into
memory.

Press the <Esc> key or <space bar> to pause the scan and view more options. The scan will stop automatically
when completed.

If you have configured options such as return to home, or automatic file saving, these will be done at the end
of the scan.

Pausing, restarting and rescanning

Press the <space bar> or <Esc> key to pause a scan. Winspect will prompt you with Scan Paused window.

For motorized scans controlled
by Winspect, the window offers a x|
limited choice. You have the option

to save any data you have collected @ The szan has been paused.
by clicking on the check box.

Winspect will prompt you for a file
name.

[ Save collected data before continuing
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If you want to make any changes, ignore the message window and then click Continue to resume the scan after
you have adjusted your instruments or scan definition.

If you click Abort, the scan will be stopped.

For manual and externally controlled scans, more options are available — see below.

Options for externally controlled scans

If you are using an externally controlled scan (either manual or machine driven), you can specify how Winspect
updates the on-screen display.

This feature is important to prevent loss of data during high speed scanning. Ideally, you want Winspect to
update the display during periods when no new data is being acquired.

To modify your externally controlled scan options click on the button in the Collection tab of the Scan
Controller.

The Online Updates feature offers you several
options. x

— Online LUpdates

You can update the display: e IW sec [0.05-30)

« Every _ sec: The display updates ona | ~ — - :
fixed time interval.

e On Pause: the display updates only

when the spacebar is pressed. [ Track Callection 'With Cursor

* On Vertical Position Change: the

display updates during movement of the

Clear Scan Data

" On Pauze Save Scan Data

" On Yertical Position Change T

— External Cantral Line

Continue Scan I

; . " Acquire When High End Scan
index axis.
" Acquire When Low e
If you want to track the position of the scan, check &+ |gnore

the box beside Track Collection With Cursor.
baotar controller must be set o extemally contralled

The External Control Line allows you to

manually control when data acquisition occurs when scanning by hand. This allows you to move the sensor
without “painting” data in areas you do not want to inspect. It is useful for inspecting regions or areas of large
surfaces without having to inspect the entire object.

You should set this control to match the switch polarity on your hardware.

& Remember that the axes must be configured for external control in the Motion Controller window.
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Saving the collected data

Collected data exists only in the memory of the computer, and is not saved to file until you do it. The only
exception to this is if you have enabled Winspect’s auto-file naming and saving feature.

Click the %

name.

button on the Winspect main toolbar to save the scan data. Winspect will prompt you for a file

You can also use the menu commands in the Winspect main toolbar: Click on the File » Data —> Save
Collected Data command in main menu.

You can also use the File > Save and File > Save As commands in the Line Plot and Color Plot
windows.

& All data subsets are saved in the file, regardless of whether you save it from the main menu, line
plot window or color plot view window.

@ See Chapter 7 —Setting up the scan for more information about Winspect’s auto-file naming and
saving feature.

Performing a Point-by Point scan

The Execute tab is the main control for Point-by-Point scanning.

x|
Click the Go button on this tab to begin taking data. D | Colecion Exectte |

— Pasition
Horizontal |4 3 in Wertical I5 3 in

— Data Callection

Click Take Data when your probe is on position and want to

record the information at this point. Winspect will record the data L
at the point specified in the Position Window. o | [CIebda] _ po

Mext |

@ See Chapter 5 for information about defining the source and type of data to be acquired when
scanning.

You can move to any point in the data array by clicking the Back and Next buttons. These are useful if you
want to return to a point in the grid and re-take the data for that point. You can also type a new location in the
Position Window boxes, if you want to go directly to a position.

Click the Done button if you wish to stop the scan before completing the pattern. You can save the partial array
of data if you wish. The scan completes automatically when the last data point is collected.

It is helpful to have a Color Plot window open while you are scanning, so that you can track the
data collection along with your positioning of the probe on your inspection grid.

w

As with all scan types, you must click the icon on the Color Plot toolbar, indicating you wish to display

the current collected data set.
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Chapter 9 - Viewing the data

Winspect has three types of viewers that you can use to display scan data. These are: Color Plots, Line Plots,
and Eddy Current Plots.

It is important to review the difference between scan data and live data. Essentially, live data is momentary,
while scan data is persistent.

Live data:

Live data can be displayed without being collected as part of a scan. Live data is not preserved in the
display; it is displayed in a strip chart or numerical readout that updates continuously. Old data is being
written over as the display scrolls along.

Scan data:

Scan data has been collected as part of a manual or automated scan. The data is organized in an array,
with defined start and end points for the data set. The data shown in a Line Plot or Color Plot is
preserved in memory and can be written to a file. Scan data held in memory this way is not written over
unless a scan is restarted.

Click (V] to display graphs of single point scan data such as amplitude, TOF, and thickness

measurements along a single axis.

Click [=2=21] o display images, such as ultrasound B-scans and C-scans, eddy current C-scans, or 3D
ultrasound C-scans.

Line Plot and Color plots can display data as it is collected during a scan, or they can display saved data from
a file.

You can open multiple Line Plot and Color Plot windows to display several data sets from any scan or saved
file.

-t
Click to display an eddy current image, including the X and Y strip charts, and the corresponding

impedance plane (Lissajous) plot.

Eddy Current Plots can only display saved data from a file. You must use a Line Plot, or the Eddy Current
Instrument display to view eddy current data as it is collected during a scan.

Capturing live data

You can capture live data without setting up a scan. This allows you to take snapshots of the data, so you can
evaluate it without trying to follow a moving display.

Live data can be captured from any active Instrument Display:

. A-scans can be captured from the A-scan Instrument Display.
. Strip charts can be captured from the Point Data Display.
. Eddy Current Plots can be captured from the Eddy Current Instrument Display.
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A-scans and Point Data strip charts are captured to a Line Plot. Eddy Current displays are captured to an Eddy
Current Plot.

All live data displays can be captured directly to a file.

To capture an A-scan
Click the menu command: File > Copy to Line Plot in the A-scan Instrument Display window

To capture a Point Data Strip Chart
Click the menu command: File = Copy to Line Plot in the Point Data Display window.

To capture an Eddy Current Display

Click the menu command: File > Copy to Eddy Current Plot in the Eddy Current Instrument Display
window.

To capture any Instrument Display directly to a file
Click the menu command: File = Save Data to File in the Instrument Display window.

Viewing data as it is collected

You can view data while it is being collected during a scan. This allows you to verify that your scan is acquiring
data properly, and allows you to view the results as the scan progresses.

In Line Plots and Color Plots:

Click on the w button inside the view window toolbar to view the collected data on-line.
You can also use the menu command: File - Collected Data.

@ See later in this section or information about viewing Eddy Current Data during a scan.

On-line scrolling update
You can set the display window to scroll along with the scan. This feature is useful for long scans, when you
may want to see only the last few inches, or the last few minutes of data displayed.

To activate the scrolling feature in a line plot or color plot window:

Click the menu command: Options = Scrolling Online Update in the line plot or color plot viewer
window.

To deactivate the scrolling display:
Click the menu command: Options = Scrolling Online Update to turn off the option.

Zooming in on a small region of the scan axis with the on-line scrolling function activated will allow you to see
a small region and its features as they are collected during the scan, no matter how long the scan axis.
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To see a zoomed in section of the collected data:

Activate online scrolling update, then:

e C(Click

to start a scan. This will set up the axes in the viewing windows to match you scan

configuration.

o Press the space bar to pause the scan. Ignore the message box asking if you wish to abort or
continue.

e Click

®

and drag the mouse inside the viewer window to zoom in on the region of interest

of the scan axis.

e Return to the Scan Paused message box, and click the Continue button to resume scanning,
or the Abort button to quit and start a new scan using this zoomed view.

Chapter 9 - Viewing the data

This zoomed in online scrolling will only work for the duration of the current scan. Once completed, the entire
scan will be displayed in the color plot window, changing the zoom level to full length.

An alternate ways of adjusting the view while online scrolling is taking place is to change the Aspect ratio. The
aspect ratio can be set by using the menu command: View — Set Aspect Ratio.

If you notice missing data in the color plot or line plot, you may need to reduce the update rate.

See Chapter 7 — Using on-line data display while scanning.

Viewing data from a file

You can open a file and display the data in four ways:

e Open a data display window (Color Plot, Line Plot, or Eddy Current Plot) and then select
File - Open from the display window’s menu.

opens a Line Plot graph window
opens a Color Plot image window.

opens an Eddy Current Plot window

e  You can also click the main menu command: Display on the Winspect main menu, then select
a display type.

or...

e Click the menu command: Display = Open Data File on the Winspect main menu, and
select the file you wish to view.

or...

e Click and drag a file from Windows Explorer into an existing data display window.

Remember that all Winspect data files are stored with the extension *.sdt, regardless of whether they are scan
images, line plots, or eddy current data.
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The description line at the top of the Line Plot or Color Plot window will indicate which subset is displayed,
and how many subsets are in the data file. You can view and print a complete list of all subsets (collected data)
within a data file by clicking on the menu command: File = Display V1 list.

Winspect data files can be saved with a text comment. You can view and edit this comment by using the menu
command: File > Edit Comment. This will open a text window that will show the comment.

If you make any changes to the data file, such as editing the text comment or adding annotations,
& y y g g g
you must save the file to preserve these changes.

Use the menu command: File - Save... to over-write the original file.
Use the menu command: File = Save As... to create a new file with your changes.

Annotations and other modifications to the data files will be discussed in detail in Chapter 10
@ — annotating images and preparing reports.

Viewing multiple data sets

If your scan collects several sets of data, these can be viewed in two ways. You can use a single viewer window,
and step through each data set. You can also open several windows at once and view multiple data sets at the
same time.

Click to step through the collected data sets one at a time.

You can also use the menu command: File > Next Subset.

& If there is more than one type of data in the file, Winspect will automatically convert the window from
a Color plot to a Line Plot to accommodate the data set you are viewing. Clicking the next subset
button will convert the window type automatically to show the data in the next subset.

Open multiple viewer windows if you want to simultaneously view several subsets from the same scan or stored
file. You can also open additional viewer windows to display scan data with a saved file, or display two or more
saved data files at the same time.

Viewing eddy current data as it is collected

There are several ways to view eddy current data as it is collected. It does not matter whether you are using a
supported instrument such as the ECT PC1 MK2 or Flare PD1000B, or you are using an external instrument
monitored with a single-point digitizer card.

The live signals are normally viewed with the Eddy Current Instrument Display. This display window shows
the entire set of data (X & Y voltage, phase & magnitude) within the same window.

Refer to Chapter 3 — Viewing Live Signals for more information about using the Eddy Current
@ Instrument Display.
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Viewing eddy current data with Line Plots

You can use line plot windows to display eddy current data in strip-chart form. This is useful if you want to
display more than one instrument simultaneously, since the Eddy Current Instrument Display can show only
one instrument’s data set at a time.

To use a Line Plot for viewing eddy current data as it is collected:

Click the il to open a Line Plot graph window.

Click the # on the Line Plot window toolbar to view the collected data on-line.

Click the 2 to step through the available instruments and data sets, until you see the instrument you want.

Click the menu command: Data and select the data you want to display from that instrument (Real Imaginary,
Phase or Magnitude).

You can open as many of these Line Plot windows as you need to display all of your eddy current data as it is
collected. Each window can be configured to show a different aspect of the same data set.

Using eddy current data with Color Plots

If you are performing an eddy current C-scan, use a Color Plot window to display the scan image, just as you
would for an ultrasound C-Scan:

To use a Color Plot for viewing eddy current data as it is collected:

Click the (2= to open a Color Plot image window.

Click the lia‘ on the Color Plot window toolbar to view the collected data on-line.

Click the = button to step through the available instruments and data sets, until you see the instrument you
want.

The eddy current C-scan displays an image corresponding to the data collected at each point in the scan. The
C-Scan image view can be switched to display any of X, Y, magnitude or phase information.

To switch the color plot data display modes, click the menu command: Data and select from Real, Imaginary,
Phase or Magnitude.

You can open as many of these Color Plot windows as you need to display all of your eddy current data as it is
collected. Each window can be configured to show a different aspect of the same data set.
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Viewing eddy current data from file

Single line or one-axis eddy current scans are displayed with the eddy current viewer or a line plot graph.

The eddy current file viewer is similar to the Eddy Current Instrument Display, except that the instrument
controls are not present. The layout also has a couple of differences:

e There is no “Next Instrument” button. All the data from each instrument is contained in a single

subset and displayed in the viewer.

e The Zoom and Pan buttons on the toolbar work on the impedance plane plot (Lissajous plot)

only.

e Zoom and Pan on the strip chart are controlled by the scroll bars at the sides of the window, and
by the colored gates within the display.

The eddy current viewer has three regions:

o A zoom window at the upper left
side, which shows the contents of the
green box from the strip chart.

. An impedance plane (Lissajous)
plot at the upper right side, which shows
the magnitude and phase of the signal
within the blue gate.

. A strip chart at the bottom,
showing the X & Y voltages (Real
& Imaginary components), a status
indicator, which shows the horizontal
position, and two indicator boxes.

To zoom in on a portion of the strip chart,
click and drag the left side of the green
box. You can also use the scroll bar at
the bottom of the chart.

i
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To change the width of the zoom window, click and drag the right side of the green box. You can also use the
vertical scroll bar at the right side of the strip chart.

There is a blue gate in the zoom window, and in the strip chart window. The position of this gate is fixed. It is
always at the center of the zoom window indicator - the green box.

To change the width of this gate, click and drag the right side of the gate. You can also use the scroll bar at the

right side of the zoom window.

72

UTEX Scientific Instruments Inc. ©2004




Winspect User Manual Chapter 9 - Viewing the data

The impedance plot shows the phase and magnitude of the signal within the blue gate. The toolbar at the top of
the viewer window has zoom controls for this display. These buttons increase and decrease the magnification of
the impedance display in four steps (100%, 200%, 400%, 800%). The number at the top right of the impedance
plot indicates the magnification level.

To increase the magnification of impedance plot, click the zoom in button on the toolbar. You can also use the
menu command: View = Zoom in.

To decrease the magnification of impedance plot, click the zoom out button on the toolbar. You
can also use the menu command: View = Zoom Out.

The status line at the bottom of the impedance plot shows the center and span of the blue gate that is generating
the impedance image. You can use this to track the signal location on the strip chart.

Eddy current data can also be displayed in a Line Plot window. This display is useful if you want to isolate
a particular section of the voltage strip chart for further analysis. The window can be switched to display X
(Real) or Y (imaginary) voltage, phase or magnitude. Click the menu command: Data to select how to display
the eddy current signal.

@ See later in this chapter for details about viewing and manipulating eddy current C-scan data.

Working with the color palette

You can manipulate how color plot data is displayed using the color palette. This can help you improve
interpretation or presentation of the scan data.

For interpretation of small differences in scan data, you can assign highly contrasting shades to data that are
close to each other in numerical value. To print reports on a laser printer and obtain good image contrast, you
may want to use greyscales. For on-screen viewing or color printing, you may prefer to use one of the color
schemes to display the same data.

You can use any combination of colors, greys, or gradients in producing a palette to highlight different regions
or different levels of an image.

Click the [® _1in the Color Plot window.
You can also use the menu command: Palette - Edit.
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The palette editor explained

There are four basic areas of the Winspect color palette editor: The spectrum bar, the data histogram, the palette
selector, and the toolbar.

{55

File ~ Edit = Scales = - ’T . . | - — Gradient colors -
(( )> | @ 9| ?I@I Grey Scales | Fainbows | Thermals | I255

—Undefined color
i | B -

92
“MO00-80 60 -40 20 O 20 40 GO0 80 100 %

The spectrum bar shows the scale defined for your color plot data. If your color plot is scaled from 0- 100%,
the spectrum bar will have the same scale. In the example above, data values at —100% of scale will be displayed
as white, and data points at +100% of scale will be shown as black. The data in between these two values will
be shown as one of 256 shades of gray.

The data histogram shows where the data points are distributed along the scale. In this example taken from a
B-scan image, most data points are between +20% and +30% of scale.

The palette selector contains four groups of color schemes: Solid Colors, Grey Scales, Rainbows, and
Thermals. The gradient number defines how many shades are used to cover the spectrum. The default number is
256 colors. In a Grey Scale scheme, there are 256 shades of gray to cover the spectrum from white to black.

The toolbar contains buttons to rotate and shift the color palette, and define the color for undefined data (set the
background color).

Using the palette editor tools

Paint a new color scheme into the color plot image:

e Click on one of the color scheme tabs in the palette selector, and then click on a color scheme.
The mouse cursor will change into a paintbrush shape.

e Click the mouse and drag the paintbrush along the spectrum bar in the palette editor.
You can paint the whole spectrum bar, or you can paint only a section where the histogram
shows a high concentration of data points.

e  You will need to experiment with this tool to determine what works best for any particular
image.

Saving a color scheme

Click on the menu command: File - Save, or File = Save As... and assign a file name to the saved palette.

A common palette can help ensure that scan images are interpreted the same way every time because image
features such as front wall, back wall, and flaws have the same color, no matter when the scan was done, or by
whom.
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Shifting the palette

Shifting the palette is useful when using a simple two-color palette to highlight a threshold level in scan
images.

Click on the « button or » button on the tool bar. Note that shifting can be destructive to the color depth,
if you are using a gradient palette such as rainbows or gray scales. Color contrast (and therefore data distinction)
is reduced. If you attempt to shift back, you will only reduce the contrast at the other end of the spectrum.

You must re-paint the color scheme in the palette editor, to restore a shifted gradient display.

Rotating the palette

Rotating the palette can show all of the data in an underlying image.

Click on the \ button or = button. This will change the alignment between the color spectrum and the
data range, which can help improve image contrast or brighten certain features in the image.

Rotating is not destructive to the palette if you lose contrast, you can rotate backwards by pressing the opposite
button, or you can continue to rotate in the same direction to restore the display.

Select the color plot scale

The scale on the palette spectrum bar is used to assign data levels to the color plot image. There are two methods
to select a different scale:

¢ In the Palette Editor, click the menu command: Scales and select a range.
or...

¢ In the Color Plot window, click the menu command: Palette - Scales and select a range.

Configuring palettes

Palettes are saved in the workspace. When you open a data file or acquire scan data, the image is displayed
using the workspace palettes. There are two exceptions:

1. Ifyou are starting a new workspace, then grayscales or Winspect default palettes are used.
2. If the data file has been saved with a specific Layout, it will have its own palette associated with the
Layout. (See below for more information about Layouts.)

To control how palettes are applied in the color plot window:

1. Right-click in the color plot, and select Configure View from the pop-up menu. You can also click the
menu command Options = Configure View.

2. In the Configure View window, click the Palettes tab.

You will have options that modify the way palettes behave:

- Use a single palette on all data subsets in the Color Plot window.

- Reset all palettes to the workspace palette(s) when switching between subsets or when
processing the current subset.

- Reset all palettes to the workspace palette(s) when a new data file is loaded into the Color Plot.
This option is ON by default, unless you turn it off. This helps ensure that image palettes
always return to a known state.
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Click the Reset All button to restore all data sets to the workspace palettes.

Click the Clear button to display all data sets with a grayscale palette.

When you save the workspace, any palettes currently in use are saved also. If you want to save
= your workspace after performing some image analysis, then use the Reset All button to restore all
displays to the workspace palettes before you save the workspace.

Click the Tips button on the Palettes tab to reveal a helper window with reminders about the default
@ palette controls.

Specifying default palettes

You can specify default palettes that Winspect will use whenever a new Color Plot window is created. If no
default palettes have been defined, Grayscales are used.

x
To set default palettes:
Zoom I Annu:utatiu:unsl Dptiu:unsl Drientationl Cursors Palettes IF'DIar 1 I ’I
1. Right-click in the color plot, and select
Configure View from the pop-up menu. I™ Use a single palette '
You can also click the menu command I Reset pallstes when switching or processing subsets Fieset &l |
Options = Configure View. [ Beset palletes when new data loaded = |
2. In the Configure View window, click
Tips
the Palettes tab. ) —=1
3' Cth the Set Defaults button on the Subset 1: IC:'\Winspect\F‘aIettes\custom‘l foo.pl2 J
palettes tab. Subzet 2 IE:\Winspect\F‘aIettes\customZ foo.pl2
4. Specify which palettes to use for Subset 3 | [
specific data sets. e [ J :I Cancel |
5. Check the box beside “Reset palettes - g pove [ J
when new data loaded”. =
[aEx - |
6. Save the current workspace.

You can use one of the standard Winspect palettes (grayscale, spectrum or thermal), or you can specify a custom
palette of your own.

Using layouts

A Layout preserves the exact presentation of your data in the color plot window, ignoring any Winspect or
workspace defaults. This tool is useful when you want to present data to another Winspect user, and you do not
know what the other user’s workspace configuration is.

Winspect data files that have been saved with a Layout, are displayed the same way every time they are opened,
regardless of the current workspace configuration.

To create a new Layout:

1. Configure the image in the color plot window exactly how you want to display the data, including the
palette, cross-section windows, and zooming.

2. Click the menu command View — Save Layout... and select one of three available layouts.

3. Click the menu command File = Save... or File > Save As... to save the data file with this layout.
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You can save a color plot image with up to three layouts. Each layout can show a different data set, or different
presentations of the same data set.

When viewing data that has been saved with Layouts, you can ignore or clear the saved layouts and use your
own palettes. Click the View menu in the Color Plot window for these controls.

Configuring Windows display settings

Winspect automatically detects your Windows system settings, and provides the appropriate palette editor for
your system, based on the number of colors selected.

You should configure your Windows Display Settings to show more than 256 colors if possible. If your palette
editor does not have a histogram, your Windows system has been configured to display only 256 colors. Try
increasing the number of colors used by Windows, so that you can use the more advanced palette editor.

Using a polar view

Winspect can display scan images in polar view. This feature is useful if you have a turntable scanner, because
it presents the data in a lifelike manner for better visual interpretation of the image.

Ea

or on the menu command: View — Polar View in the Color

To display data in a polar view, click the
plot menu.

The polar view menu and button option is only available when the data has been acquired with a rotary axis in
a flat scan.

Cylindrical or helical scans cannot be displayed in polar view.

Configuring a polar plot view

Right click the mouse inside the Color Plot window. The Configure View window will appear.
Click the Polar View tab to see the configuration options.

The default configuration, which gives

.ﬁ.nnntatinnsl Elptiu:unsl Drientatinnl Eursu:ursl Palettes  Polar ||:|B 1 I "I S )
the most realistic image is:

—Ch I f polar displap—————— — Select rezoluti .
e o Sk remu_ ol Plot Style:[X, Y] and Combination
Flat style v Automnatic . .
Technique: Maximum
Combination techhigue ID-1 i
: : You can specify a polar display during
— Optiohe — Rotate image by . Lo . .
_ _ _ collection. This is useful if you are using
[ Show polar display during collection IEI degrees a live display update during scanning.
[ Show all data az polar [when possible]
I™ Shaw polar data in 1:1 aspect ratio Pular iz | You can rotate the image any number of

degrees.

Click Apply to implement the changes, or OK to implement changes and exit the Configure View window.
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Using a dB view

You can display collected data in either linear scale or logarithmic decibel (dB) scale. The conversion is
performed on the basis of the largest amplitude value in the data set. All data are displayed as —dB down from
the highest amplitude.

To display data in dB view, click the icon the Color Plot toolbar, or click the menu command: Process

- dB.

In dB view, the palette, the measurement cursor and the coordinates readout at the bottom right of the Color
Plot window will automatically display measurements in dB.

You can switch back and forth between the raw (linear) and dB views by clicking on their labels at the top-left
corner of the Color Plot window.

Making measurements on images and graphs

Winspect includes cursor tools for making measurements on the image or graph display. These tools can be used
for a variety of purposes, such as sizing a flaw, or determining distance to a reflector.

In each viewer window, there is a status indicator at the bottom of the window. This displays two types of
position information, based on how you use the mouse.
e If you move the mouse around inside the image or graph area, the indicator displays the current
cursor position, and the value of the data point at that position. This is called absolute mode.
e Ifyou click and drag the mouse, the status indicator displays the distance between the start and
end points of the drag, and the difference between the data values at those points. This is called
relative mode.

The type of information displayed on the status bar will depend upon the viewer you are using:

¢ In line plots, the cursor position along the scan axis and the waveform amplitude or data point
value are displayed as (X, Y).

e In color plots, the cursor position is displayed as (X, Y). The data value at that point in the image
is displayed as “=123.456”.

e In color plots with polar view, you can display the cursor position as radius and angle (r, theta).
In eddy current plots, there are three status bars, one in each region of the display. These will be
discussed in detail below.

Making a measurement

Click and hold the mouse, and drag it between two points in any image viewer. The mouse will show a rectangle
with corners at your start and end points. The status bar will display the distance between these points, and the
difference between their data values.

Increasing measurement accuracy

Use the Zoom-in feature of any viewer window to increase your measurement accuracy. In most cases, you will
be able to zoom into the level of resolution of the scanning axis. In B-scans and Line plots, you will be able to
zoom into the resolution level of the digitizer.

You may also wish to maximize the viewer window temporarily by double-clicking on the title bar of the
window. This will make the viewer full-screen size. Double-click the title bar again to restore the original
window size after you have completed your measurements.
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Making measurements in line plot views:

You can make several kinds of simple measurements in Line Plot views. The example below shows an A-scan
extracted from a data file.

ﬂ Line Plot - memory resident (1 of 1) ;Iglll

File ‘ew Scales Options Process Analysis Edit Data  Window

TEUWME PLe MNEAm O w

= 19 20 21 22 23 24 25 26 2

Ready << 1.460, -37.500>> | 2

The status bar shows a delay of 1.460 us between the front wall and the first flaw echo.

The vertical measurement (-37.5% of scale) is the difference in amplitude of the two echoes.

The example below shows a magnified view of the same signal.

_igix
File Wiew Scales Options Process dnalysis Edit Data  Window
TEODHS 2L+ M=

usec

20.5 20.6 20.7 20.8 20.9 21.0 21.1 21.2
1 1 1

Ready << 0.080, -58.9845> | =

The full-wave amplitude measurement is 59% relative to the full display scale of 100%.

This can be used to size flaws when compared to signals from a calibration block or some other reference
standard.

The horizontal measurement shows a period of 0.160 ps for this wave, or a center frequency of about 6.2
MHz.
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Making measurements in color plot views

In the color plot below, a C-scan displays amplitude in a 10 mm by 10 mm area of a sample with holes of
different sizes. Click the buttons in the Color Plot viewer toolbar to turn on and off displays showing cross
sectional line plots of the C-scan view.

g |

Displays or hides the horizontal cross section view.

=
a2

Displays or hides the vertical cross section view.

Color Plot - ©_SCANAT.SDT (1 of 2) =lolx]

Fle Wiew Palette Options Process Analysis Edit Data Window

2B HS AL+ HEE=$=EE &=

Click the mouse in any area of the C-scan image
to see the horizontal and vertical cross-sections
at that point.

The left side of the status bar indicates the
position of the cross section windows: 2 mm
Horizontal and 2.7 mm Vertical.

The right side of the status bar indicates the
current cursor position and the value of the
data point at that position. Moving the mouse
around the image will update this status
indicator without affecting the cross-section
windows. Click in a new location to update the
cross section windows.

LI -
. R g
- -

To obtain a measurement, click and drag the o s o & 20 9370 1700 m .00 mer) = 52,051 o I8
mouse in either the image area or the cross

section areas of the display. The right side status bar will display the distance between the starting and end
points of the drag. It will also indicate difference between the data values at those two points.

The cross section windows will display the cross-section at the end-point of the drag.

Configuring the measurement cursor

In the Color Plot window, you can specify the type of cursor and its behavior.

To modify your cursor, right click the mouse inside the Color Plot window. This will open the Configure View
window, where you can select the Cursor tab.

ETTTTEE— x
SeleCt SpeCiﬁC OptiOHS for your Cursor: Zoom I Annotationsl Dptionsl Drientation  Cursors I Palettesl Palar 4 I L4
. —Me. I ———— InPalar Yiew, show
Measure Distance by- i« % [.p] coordinate position
Select whether distance is measured by XY coordinates " Diaganal length {1, thets) coordinate position
or by angle and a diagonal length —Amplitude meazurement — Curzor shape
. & Linear Amplitude Differsnce % Rectangular Cursar
Amplltude Measurement: i Amplitude Difference in dB " Circular Cursor
Select Linear or dB measurement (Ui Gl
Clll'SOl‘ Shape' Fosition: |3— Feadout: |3—
Choose round or rectangular wel | [ ||
Polar View:

Show cursor position as X, Y coordinates or as radius and angle.
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Calculating image area statistics

You can measure the area of any part of the image, and calculate some statistics about the data in that area. This
is useful when measuring defect size, or when reporting on other features in the image.

To calculate an area:
Click the menu command Analysis = Area Statistics, then click and drag the mouse in the Color Plot image.
The area you define with the mouse will be used in the calculation.

A window will pop up that displays the start and end points of the drag, and the area it defines. There are several
other useful things you can calculate using this window:

. Enter a Volume Scale Factor to calculate the volume defined by the area times the depth represented
by the volume scale factor.
. Enter a Threshold value to calculate the percentage of data points above and below that threshold. This

is useful for determining whether defect reflectors are at or above critical values.
Click the Calculate button to perform the requested calculations.

More sophisticated measurements are also possible. See Chapter 11 — Annotating Images and
@ Preparing Reports for more information on this topic.

Making measurements in eddy-current views

The image below shows an eddy current scan of a notched heat exchanger tube. The strip chart scan axis shows
degrees of rotation around the circumference of the tube.

To improve your measurement accuracy, it is helpful to maximize the window where you are working. Double-
click on the window’s top frame, or use the Maximize button at the top right of the window.
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The cursor position is displayed on the status bar at the bottom of the window. This displays two types of
position information, depending on how you use the mouse.

* If you move the mouse around inside any area of the display, the indicator displays the current
cursor position, and the value of the data point at that position. This is called absolute mode.

* Ifyouclick and drag the mouse, the status indicator displays the distance between the start and
end points of the drag, and the difference between the data values at those points. This is called
relative mode.

To measure the Real and Imaginary portions of the signal, click and drag the mouse in either of the two strip
chart regions. These measurements are most accurate when made in the zoom view at the top left of the
window. Position this window at the desired location by dragging the scroll bar at the bottom of the strip chart.
You can change the magnification by dragging the scroll bar at the right of the strip chart.

To measure magnitude and phase angle, click and drag the mouse in the impedance plane portion of the viewer
window. The status bar at the bottom of the window will display the coordinates in the impedance plane,
followed by the magnitude and phase angle. Use the Zoom In/Out buttons on the main toolbar to increase the
magnification and get better measurement accuracy.
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Chapter 10 - Processing the data to improve its usefulness

Winspect has many tools to make processing and analyzing complex data a simpler task. You have already
used one of these tools if you have used the color palette. This tool improves image clarity and resolution for
qualitative visual analysis.

For quantitative analysis, data conversion, or data reduction, you can use a wide range of processors in a variety
of ways.

Understanding Winspect processors

Processors perform two types of task: data transformation, and data extraction.

* Data Transformation performs a reversible operation on a set of data, without reducing the
dimensions of the data set. Examples include frequency analysis via FFT, filtering to reduce
noise, and converting the waveform time axis to a distance measurement.

» Data Extraction performs a reduction on the data to obtain a single point from a waveform,
FFT or other data set. Examples include extraction of peak amplitude and time-of-flight from
a waveform, or extraction of a peak frequency from an FFT spectrum.

Both types of processing task can be combined in a compound processor that performs multiple sequential
operations. You build these sophisticated processors, using the set of standard processors as building blocks.
For example, you can filter a noisy signal, obtain the FFT frequency spectrum of a particular waveform and
then determine the peak frequency and bandwidth. See later in this chapter for details about creating custom
processors.

You can control the behavior of any processor through its Properties. This will also be outlined later in this
chapter.

There are three ways to use a processor. You can:

* process a display, altering the way a signal is represented.
* process the data that is collected in a gate.
* process data from a saved file, and save the processed results along with the raw data.

The results you obtain from a processor depend upon how it is invoked. See the sections below for details about
how to use each type of processor.

Processing live displays

The A-scan Instrument Display includes tools to change the way a signal is represented on screen. These
display processors do not actually alter the data; they merely display it in a different manner, so that the signal
can be interpreted in a variety of ways.
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Three of the most commonly used display processors are available through buttons on the A-scan Instrument
Display toolbar.

Click m to view a full wave rectification on the signal. Click again to return to an RF mode display.

@
Click L=21 to convert the Time axis to a Distance measurement. Click again to return the distance axis to its
normal time base. The first time you invoke the Time-to-Distance processor, Winspect will open a window with

controls to specify how the measurement is made.

| . : .
Click to view the FFT (Fast Fourier Transform) spectrum of the A-scan signal.

Additional display processors are available through the A-scan Instrument Display menu. Click the menu
command: Tools = Choose Display Processor to see the list of available processors.

If you have created a custom processor, it will be available in this selection list. See later in this chapter for
details about creating custom processors.

There are three important things to remember about display processors:

*  Processing a display does not change the data. You are merely showing a different
representation. You must use a gate to process the data if you want to record processed data.

*  You can display an A-scan signal and its processed representation at the same time, by using a
split-pane display. See Chapter 3 — Using The A-scan Instrument Display for instructions.
You can display several different processed views of the same signal.

*  Most display processors have properties you can edit to control the way the processor operates.
Click the menu command: Tools = Edit Display Processor Properties to configure the
display processor.

Ea Ascan Instrument Display ) o =[5
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Processing gated data

You can apply processors to any gate in the A-scan Instrument Display. The processor operates on the gated
portion of the signal, and the processed data is saved in the scan data file.

Processors for gated data are listed as Definable Data Types in the Gate Properties window. You must apply
a gate to the signal and then select processors, just as you would select a standard data type.

Gate Propetties x|

— Gate Position—————————  ~ Definable Data Types

M ame: ||F Choices;

Azcan Amplitude
Delay: |22 uzes tatlab 10 Processor
R ange: |2D uzeC
Threshald: ID-E Walts

Lewvel Croszing Faonward
Interface e = Level Croszing B ackward LI
trigger gate:

Y Add
— Standard Data Types———————————— v

[ JAmplitude: &bs. Value Selected
ERmplituce: e Peak Center Position
[ JAmplitude: Minimum
W TOF to Threshold
[]TOF to +ve Peak
[]TOF to -ve Peak
[w]' aweform

Peak Pozition
Single Paint
Peak Center Pogition

Properties. .. Delete
Cloze I ¢ Less |

You can select any number of standard and definable data types.

You can edit the Properties of definable data type at any time. This enables you to control how the processor
operates on the gated signal.

See Chapter 5 - Defining the source and type of data to be acquired for more information about
@ using gates and definable data types.

Each processor you apply through the selection of Definable Data Types operates independently. If you
want to perform sequential processing operations, you must define a custom processor and add it to the list of
Definable Data Types.

Processing saved data

You can process data after it has been collected in a scan. You can do this before the scan data has been saved,
or you can recall a data file and process the saved data.

Saved data processors are used in the Line Plot, and Color Plot windows.

Many data files contain several data subsets. To process a data subset, step through the subsets using the
button, until you see the subset you want to process.
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On the menu bar, click the menu command: Process = Process Subset. x|
A menu will pop up, from which you can select a processor.

A-Scan Int Trig Gate
. . Fu' Rectify
Any custom processors you have created will appear on the menu, following Envelope

. Butterwarth Filker
the list of standard processors. Time ta Distance

FFT
dE Corverter

. . . . Remaove Centering Offzet
Click on a processor and click OK to select it. If the processor requires Satis oty b

parameters to control how it works, Winspect will pop up a menu so you Linearize [
can edit the processor properties Applies a gate to your A-scan or ling data

The processed data is displayed in the same window as the raw data. You
can flip back and forth between them by clicking on the blue titles at the top
of the window. The underlined title indicates which data is displayed.

You can perform sequential processing operations by repeating the Process Subset command. Each new
processor result appears in the title list. You can click through the sequence of processor results by clicking on

Cancel |

their titles.
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You can re-apply processors at any point in the sequence. Simply click on its title, and repeat the Process Subset
command. This is useful if you are not sure what parameters to use for a given operation, such as the cut-off
frequency for a filter. You can also select a completely different processor.

If you re-apply a processor in the middle of a sequence, the new result will replace all of the
(= subsequent processors. You should save any results that you want to keep before re-applying an
intermediate processor.

To save the processed data, click the menu command: File = Save Processed Data As... on the menu bar of
the line plot or color plot window.

Only the current (underlined) data set is saved. If you have performed multiple operations, you must select each
processor result and save it individually.
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Controlling the properties of Processors

Almost all processors have some properties that you can edit to control how the processor works. This applies
to all three classes of processor - display, live data, and saved data processors.

Display processors

To edit display processors, click the menu command: Tools = Edit Display Processor Properties on
the A-scan Instrument display menu bar.

The Time-to-Distance processor has its own listing in the A-scan Instrument display menu bar. To
edit the Time-to-Distance measurement, click the menu command: Tools = Edit Time to Distance
Properties .

Gated data processors

To edit gated data processors, open the Gate Properties window for that gate. There are two ways to do this:
*  Double-Click on the gate you want to edit.
* Right Click in the A-scan display, and select: Gate Properties - Gate from the pop-up
menu.

Click the More >> button to extend the Definable Data Types section of the Gate Properties window.

Click on the processor you want to edit, and then click the Properties button to expose its properties.

Saved Data Processors

When you call up a processor in the Line Plot or Color Plot windows, the processor properties are presented so
you can define how the processor will operate on the data set.

To edit an existing processor result, simply reapply the processor, and select new parameters.

Remember that reapplying a processor in the middle of a sequence will delete all of the subsequent
results when the new processor runs.

Creating your own processors

You can create custom processors that perform sequences of operations on the data. These sequential processes
can be as simple or as complicated as you need. They are all very easy to create. The standard processors are
the building blocks for these custom processors; you simply chain them together in a sequence.

Creating a custom Processor
To create a custom processor, click the menu command: Processing - Edit Processors on the main menu
bar.

The Processor Management window will appear, showing the list of basic processors.
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To add a new Processor Group, click on the Add button. A new tab will be added to the Processor
Management window, called User Defined Procs. You can edit this default name to assign a meaningful title

to this group of processors.

You can add several groups of custom processors. Each
new group is organized under a tab in the Processor
Management window.

To add a new processor to a group, click the tab to open
the group, and then click the Add button to create a new

You build a custom processing sequence by combining
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basic processors from the list on the left.

You can define the default properties for any processor
in the sequence. These settings will be used whenever
the processor is called. Click on a processor in the
Processing Sequence box, and then click the Edit
Properties button to modify its properties.

Edit Processing Sequence
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Delete
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Cancel
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These properties are visible when the processor is
invoked, and can be changed while the processor is
running.

oK |

4

Exposed properties enable you to control your custom processor in Winspect without having to edit the sequence
and change its default properties.
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To finish creating your new processor, click the OK button. The window will close and the new processor will
appear in the Processor Management window.

You can add any number of processors to a group.

You can edit a custom processor at any time after you have created it. Click the main menu command:
Processing - Edit Processors. You can alter the default properties, add processors, or delete processors
from the sequence.

Using a custom processor...

You can use a custom processor exactly as you use the basic processors. It will be available for processing
displays, gated data, and saved data sets.

When you invoke a custom processor, it runs with the default settings you defined when you created it.

If you configured any exposed properties for the custom processor, these will be displayed for editing when you
select the processor to run.

In A-scan Displays:

The custom processors you create will be added to the list of available display processors in the A-scan
Instrument Display menu.

Click the menu command: Tools = Choose Display Processor and scroll through the list. New
processors are added to the end of the basic processors list.

To Process Gated Data:

Custom processors will be available for selection in the Gate Properties menu. Click the More >> button
to expand the Gate Properties menu, and scroll through the list of Definable Data Types.

To Process saved data:

Custom processors are also available for processing saved data, in either the Color Plot or Line Plot
windows.

Click the menu command: Process = Process Subset... and scroll through the list to find the custom
processors.
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Processing a data subset

Processors can be applied to any set of Winspect data after it has been collected in a scan. This is done in the
Line Plot, Color Plot, and Eddy Current Plot windows.

Tools that act on common data types will be available in all of the viewer windows. Tools that act on specific
data types are available only in the appropriate data display window. A partial list of the most common
processors is given below.

Line Plots

Time-to-Distance Conversion

You can perform time-to-distance conversion on the horizontal axis to determine water path, or to confirm the
location of echoes such as flaws and back wall. You will need to specify the velocity of sound in the material
you are using.

Click the menu command: Analysis = Time Axis = Distance. A window will pop up with inputs to specify
how the calculation will be done.

You can select wave type and material from the list, or you can specify a velocity for Winspect to use.
Indicate whether the sound path is direct (through transmission), or a round-trip echo. You can also specify an
angle for non-perpendicular probes.

Specify an offset distance and time to accommodate the water path, or a delay line.

Data Value Interpretation

The default Winspect display for data values is percentage of full scale. You can assign units and label the Y-axis
to make the data more relevant to your application.

Click the menu command: Analysis - Interpret Data Values to assign interpreted values to the data, and
modify the Y-Axis label.

Spectral Analysis

Winspect will perform Fast Fourier analysis on any data within a line plot window.
Zoom in on the region of interest, then click on the menu command: Data = Magnitude Spectrum to view
an FFT of the data set displayed in the line plot.

Click the menu command: Process = Spectral Analysis to view the frequency statistics (peak frequency,
bandwidth, etc.) for the data set displayed in the line plot.

FIR Filter

Winspect includes a Finite Input Response (FIR) filter on the line plot window. This is useful when working
with under-sampled data, because it increases the number of points on the time axis by a factor of four.

Click the menu command: Options = FIR Filter to process the data in the line plot window using the FIR
filter.
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Hanning Window

You can use a Hanning window to reduce the contribution of signals on either side of the signal of interest,
before performing an FFT.

Click on the menu command: Options - Use Hanning Window to process with a Hanning window when
performing an FFT spectral analysis.

Exporting data

Winspect will export single-point scan data to a text file. You can then import this data into a spreadsheet or
other analysis program.

Click the menu command: File > Save As.... When Winspect prompts you for a file name, click on the box
beside Save As Type, and select *.£xt to save the data as a tab-delimited text file.

Ultrasound Color Plots

The tools available in the color plot window will depend upon the data type displayed. For example, Time Axis
to distance conversion is only available for B-Scans.

Simple tools that are available for both B-Scans and C-scans include:

Data Value Interpretation

Winspect displays the data in the color plot window as percent of full scale or volts, depending on the type of
instrument used. You can assign a label and units to these data values to make them more meaningful.

Click on the menu command: Analysis = Interpret Data Values to assign interpreted values to the data, and
modify the axis label.

Time-to-Distance Conversion

You can perform time-to-distance conversion on the horizontal axis of a B-scan. Click on the menu command:
Analysis - Time Axis --> Distance. A window will pop up with inputs to specify how the calculation will
be done.

*  You can select wave type and material from the list, or you can specify a velocity for Winspect to use.
*  Indicate whether the sound path is direct (through transmission), or a round-trip echo.

*  You can also specify an angle for non-perpendicular probes.

*  Specify an offset distance and time to accommodate the water path, or a delay line.

dB Conversion

Color plots can be displayed in decibels or linear scales.

Click the dB button on the color plot tool bar to display the data in log scale. You can also click on the menu
command: View = dB View.
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Cross section extraction

You can extract a cross-section from a B-scan or C-scan image in the color plot window. The cross section will
be displayed in a new line plot window.

Click on the menu command: Process = Extract - Cross Section, then click the mouse in the image
window at the point on the axis where the section is to be taken.

e (C-scan cross sections are graphs of the data (amplitude, TOF, etc.) along either the X or Y-axis.

*  B-Scan horizontal cross sections produce the A-scan for the selected point on the scan axis.

e B-Scan vertical cross sections produce a line graph of the signal amplitude along the scan axis
at the selected time-of flight.

Data Cropping

You can eliminate extraneous data from your image by cropping. Click on the menu command: Process —
Crop Data.... Select whether you want to crop the data inside or outside the cursor. Click and drag the mouse
in the image window to define the area you want to crop.

Note that this tool works only on the displayed subset. If you have multiple data subsets, the other data subsets
will not be affected.

Data Resizing

You can delete data from your scan by resizing the scan. Click on the menu command: Process > Edit >
Resize.... A window will appear that prompts you to enter the new scan size. If your view is zoomed in to the
region of interest, you can click on Get Current View to automatically re-size the scan. Click OK to accept the
new size and exit.

Data resizing eliminates data and cannot be undone. You must re-open the data file to restore the eliminated
data. Click the menu command: File = Re-open. Data resizing eliminates data from ALL subsets in the scan
file, not just the currently displayed subset.

Subset Deletion

Click on the menu command: Process = Edit > Delete all other subsets to retain only the currently
displayed data set. Use this feature to reduce data file size by eliminating un-needed data sets.

Data Rotation

You can rotate the data in a color plot windows. This is useful for aligning rotary scan data with a particular
point on the rotary axis. Click on the menu command: Process = Rotate Data. Click and drag the mouse
horizontally in the image window to define the rotation.

Rotary axis to circumference conversion

Winspect can convert a rotary axis labeled in degrees to display the axis as distance around the circumference.
You must know the radius of the inspected object to use this feature.

If you have an image scanned with a rotary axis, the tool will be available in the color plot window under the
menu command: Analysis = Rotary Axis = Circumference.
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Custom Processors

Winspect includes a number of custom data processors, which can be used to analyze and manipulate scan data
after it has been collected. These advanced tools are available under the menu command: Process = Custom in
the color plot window.

Processing Eddy Current C-scans

You can extract cross sections from an eddy current C-scan image. The resulting data is a normal eddy current
strip-chart showing X and Y voltage and phase for one pass along the inspected object. The cross section can be
extracted to show a horizontal or vertical scan.

The image at right is a C-scan of a 10 mm section of heat exchanger tube, with induced flaws cut at various
depths along the length of the tube.

Click the menu command: Data to switch the data display the show X, Y, magnitude or phase information for
the scan.

As with ultrasound C-scans, eddy current C-scan images can display cross section windows.

Extracting an eddy current plot from a C-scan
Click the menu command: Process = Extract > Horiz. Lissajous then click on the C-scan image to indicate
where the cross section will be extracted.

Winspect will open a new eddy current window and display the Lissajous (eddy current) plot of the X&Y strip
chart at the selected Y-axis location.

To extract a Vertical Lissajous, click on the menu command: Process = Extract = Vert. Lissajous.

Using the Cross Section Window

You can view the cross section of the C-scan in a dynamic eddy current window.
Click the menu command: Process = X-Section Window —> Horiz. Lissajous.

This will open a blank eddy current window. When you click in the C-scan image, the eddy current window will
dynamically update to show the strip chart at that location of the C-scan. This allows you to “replay” the scan
showing the display, as it would have appeared during the scan.

To extract a Vertical Lissajous window, click on the menu command: Process - X-Section Window — Vert.
Lissajous.

Eddy current plots extracted from a C-scan can be saved individually. Click on the menu command: File -
Save in the eddy current display window.
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Using Custom Processors

Custom data processors are available for eddy current C-Scans. These tools can be used to manipulate the
eddy current data after a scan has been completed. They operate on the data in a similar way to the instrument
controls operate on live signals.

The Custom Process tools available for eddy current are: Lissajous Balance, Lissajous Rotate, Lissajous De-
Glitch, Lissajous Remove Undefined, and Lissajous Filter.

Capturing impedance plots

In an eddy current viewer, you can capture one or more impedance plots for comparison. Increase the number
of windows by clicking on the menu command: Window - Increase Number. Repeat the command for as
many windows as you need.

Click the mouse and drag the image from the impedance plot into one of the new windows at the top of the
display.

Move the scroll bar at the bottom of the window to move the gate to a new location on the strip chart.
Click and drag the mouse to capture the new waveform from the impedance plot window.

You can drag the waveform plot into an empty window, or you can drag it on top of an existing window and
replace the previous waveform capture.
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Chapter 11 - Annotating images and preparing reports

Annotations are comments and measurements that you add to the scan image. These annotations help you to
create a report, which can be printed, saved or exported to other programs. Annotations are a powerful way to
record your analysis of the scan data and communicate it with others.

Annotating images with text

ab

To place text on an image, click the
to place the text.

button on the color plot toolbar. Then click the location in the image

The Annotations window will appear. Click the X

word “New” in the text field, and type the text

. . Font i
you want to add. To complete the annotation click Test  Forl | Fosiion| Subsers|

Apply or OK.

PPy Fant IAriaI vI [~ Bald

. . i |‘|2 [ Italic
You can create a list of frequently used annotation L
words or phrases. These are shown on the Text Drieritation [0 degrees I™ Underline
tab in the annotations window. Fareqiound color Iblack -]
Backaround calor Itlanspalent vl Set Ag Default |

The Font tab is used to modify the appearance of

the text. Larger fonts are useful for titles, smaller o |
fonts for notes within the image.

Cancel |

The Position tab has controls to specify text appearance: You can indicate that specific text is a title block, and
make its position absolute. A title will not move with respect to the image when you pan, or zoom. Normal
annotations are positioned at the top left corner of the text. This corner is positioned at the closest pixel of
data.

The Subsets tab is used to specify whether the annotation is displayed only with a specific data set, or with all
data sets. This is useful if you have multiple data sets, and you do not want to clutter one image with comments
that belong to a different data set.

To edit annotations:

Right-click or Double click the text on the image. The Annotations window will appear. You can edit the text
as well as the font style. Click Apply to update the annotation without closing the Annotations window. Click
OK to accept the changes.

To modify the properties of an existing annotation:

Right-click the text to obtain window with the same controls as the Font tab. Click Apply to update the
annotation without closing the Annotations window. Click OK to accept the changes.
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To move annotations:

Click on the text to highlight the annotation with corner handles, and then drag the text to its new location.
To delete annotations, click on the text and press the <delete> key.

Annotation text can be hidden from view.

Click the 2] button to toggle the text display. This command hides all annotations — not just the ones for the
current data set.

Annotating images with measurements

You can also use annotations for making measurements on the scan image.

Click Options = Annotations in the color plot menu bar, and select a:
* Point: Click the mouse to measure and annotate the selected point.
*  Vector: Click and drag the mouse to draw a line and measure its length.
* Box, Circle or Ellipse: Click and drag the mouse to enclose an area and make measurements.
* Polygon: click the mouse at several points to draw your polygon. Press the <Esc> key to stop
drawing.

Winspect will prompt you with a window to select one or more measurements, and allow you to annotate the
image with the results.

Click on any number of check boxes to select measurements.

Click Compute to see the calculated Measurementsluneg | Points | Subssts |

results.
Selected Measurements: R esults:
. [Length .
To exit the measurement calculator [tk
[JArea

w%thout wrltlng results to the_ image., S pot Width Ratio
click OK without Annotating the [ | M axirnum (20

Display. The original annotation shape EELHAFSSTE[E‘JEF]

will remain visible. D.ﬁ.verage [ED] ;I

Choose to Annotate Display, if you Compute I Annotate Display
want the results added to the selected

measurement.

Click Apply to add these changes without closing the measurement calculator.
Click Cancel to abort the annotation and delete the shape. No text will be drawn in the image.

To modify the properties of an existing measurement annotation, right click the object to open a window with
color and line thickness options.
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(D See the Reference Guide for more information about specific annotation tools and their use

Copying images to the Windows clipboard

You can copy a scan image from the color plot window to the Windows clipboard. You can also save the scan
image to a file.

From the File menu in the Color Plot window select Export Bitmap = To Clipboard. The clipboard image
can then be pasted into any other software application.

& Only the bitmapped image is exported to the clipboard. The underlying data is not exported.

Exporting images to other programs

From the File menu in the Color Plot window select Export Bitmap — To File. This opens a window in
which you can select a folder and type a filename.

= Only the bitmapped image is exported to file. The underlying data is not exported.

Printing reports
Your printed reports will contain the scan image, annotations and additional information you specify, such as
user defined information, axis, and scale information.

In the Color Plot or Line Plot window, select File = Print Displayed Image. This opens the Print Options
window, where you can select the information you want to include in the report.

If your image includes cross-section Print Options x|

windows, you can indicate whether they are

) . ) i — Print Crogs-zections
printed, and specify the width of the print [ eaae E et |1_5 =
region for both cross-sections. [T Axiz Summary Information [~ wertical I‘IE— ifn
¥ Scale
The Mode message explains how the image [ IS e aer nedlr rermatiar
will be printed. See below for details about S
configuring the print scale and size relative The print region will be the visible area on the display. This area will be
to the screen irnage. expanded to fill the awvailable area on the printer.

Click OK to send the report to the printer.

0k I Cancel

To printin 1 to 1 you must view the image in 1 to 1. The visible area of the image will then be printed
@ in 1 to 1 aspect ration.
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Configuring the image display

Winspect displays each data point from a scan as a pixel in a color plot image. You can control how these pixels
are displayed and printed. The on-screen image configuration is also used to determine the configuration of the
printed image.

Right click in the color plot window to open the Configure View window.
You can also select the menu command: Options = Configure View from the Color Plot window menu.

Configuring image magnification
The Zoom tab contains Aspect Ratio controls.
Aspect ratio is the relationship between the width and the height of the scan image.

If your inspection used a different
sample resolution for the scan and
index axes, the physical spacing of
data points may not be symmetrical.

Winspect can adjust the display to Zoom |.-’-‘-.nnn:|tatin:|ns| Elptin:nnsl Drientatin:nnl Eursarsl F'alettesl Polar 4 I *I

show the data in a 1:1 aspect ratio. ~ Set Aspect Ratio

™ 1:1 Azpect ratio by unitz  Scale; I'IEIEI X Life Sized |
C_th Apply to see changes in the ™ 1.1 Aspect ratio by pixels Fixel per F'u:uintl
viewer window, or click OK to set
the change and exit the Configure + Stretch to window extents
View window.

[T Aspect Batio locked Zoormn Qut |
Cancel |

1:1 Aspect Ratio by units
configures the display to match
the physical units specified for

&ppl
your scan and index axes. The ﬂ
screen image will appear properly
proportioned relative to the scanned

object, even if the sample spacing
for each axis was different.

Enter a number in the Scale box to control the size of the image; 100% shows the object at life size. Specify a
larger or smaller scale to increase or decrease the image size relative to the actual object.

The Life Sized button sets the view at a 1:1 Aspect ratio by units and scales the image to 100%, so that the
screen image will match the true size of the scanned object.

1:1 Aspect Ratio by pixels configures the image to show one square pixel per data point. This view shows
the data points in correct relationship to each other. The dimensions of this view may not match the physical
dimensions of the scanned object.

The Pixel-per-point button sets the view at 1:1 Aspect ratio by pixels and scales the image to show one data
point per screen pixel, giving the best possible image.
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Fit to Window adjusts the image to fill the display area of the color plot window. The aspect ratio will not
necessarily be 1:1 for this display configuration.

The Zoom Out button adjusts the image to fit within the dimensions of the color plot viewer.

Configuring image layout
Click the Options tab to configure margins, to show or hide scroll bars and axis labels, and to configure the
cross-section display windows.

Title: adds a margin above the axis or

i : ; Zaarm I Arnotations  Options I Drientatiu:unl Eursnrsl F'alettesl Palar 4 I ’I
cross section box if one is present.

: ~ Margi ~ Cross-secti
Left / Top: adds a margin between = | il |
the axis and the image. This is a useful [ Title in ™ Horizortal |1 in

place for descriptive labels. [ Left i [~ Wertical |1 if

Right / Bottom: adds a margin to the
[T Accumulate Clear |

outside of the image.
W Label axes W Show scrollbars

[~ Right

Cross Sections: You can configure I~ Tap
both size and behavior.

[ Bottom

TIT
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